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Getting started
 WARNING

See the Important Safety and Product Information guide in the product box for product warnings and other 
important information.

• Update the maps and software on your device (Map and Software Updates, page 60).
• Mount the device in your vehicle and connect it to power (Mounting Considerations, page 2).
• Acquire GPS signals (Acquiring GPS signals, page 5).
• Adjust the volume (Adjusting the volume, page 6) and display brightness (Adjusting the screen brightness, 

page 6).
• Set up a vehicle profile (Adding a vehicle profile, page 7).
• Navigate to your destination (Starting a route, page 22).

dēzlCam Device Overview

Microphone for voice command or hands-free calling

Power button

USB power and data port

Camera memory card slot

Map and data memory card slot
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Installing the dash camera memory card
Before the device can record video from the integrated dash camera, you must install a camera memory card. 
The camera requires a microSD® memory card from 4 to 256 GB with a speed rating of Class 10 or higher. 
You can use the included memory card, or you can purchase a compatible memory card from an electronics 
supplier.
NOTE: a memory card is included so your device is ready to use out of the box. All memory cards have a limited 
life and must be replaced periodically. Your device alerts you when the memory card has exceeded its useful life 
and needs to be replaced. You can follow the troubleshooting tips to help extend the useful life of the memory 
card (My memory card has degraded and needs to be replaced, page 66).
1 Insert a memory card  into the camera memory card slot .

NOTE: if you install the memory card into the incorrect slot, the camera cannot record video.

2 Press it in until it clicks.

Mounting Considerations
• Do not mount the device in a location that obscures the driver's view of the road.

 WARNING
It is your responsibility to ensure that the mounting location complies with all applicable laws and ordinances, 
and does not block your view of the road during the safe operation of your vehicle.
• Choose a location that allows you to route the power cable safely.

 WARNING
When installing the device in a vehicle, install the device and power cable securely so they do not interfere with 
the vehicle operating controls. Interference with the vehicle operating controls can result in a collision, which 
could result in injury or death.
• Choose a location that is within easy reach.
• Choose a location that provides the dash cam with a clear view of the road.

You should verify that the vehicle's windscreen wipers clear the windscreen area in front of the dash cam, 
and you should avoid placing the dash cam behind a tinted area of the windscreen.

• Thoroughly clean the windscreen before installing the mount.
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Mounting and Powering the dēzlCam Device in Your Vehicle
 WARNING

This product contains a lithium-ion battery. To prevent the possibility of personal injury or product damage 
caused by battery exposure to extreme heat, store the device out of direct sunlight.

Before you use your device on battery power, you should charge it.
1 Press the suction cup to the windscreen, and flip the lever  back toward the windscreen.

2 Plug the vehicle power cable into the USB port  on the device.
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3 Plug the other end of the vehicle power cable  into a power outlet in your vehicle.
4 Fit the tab on the bottom of the mount into the slot  on the back of the device, and press the device into 

the mount until it clicks.

Turning the device on or off
• To turn the device on, press the power button , or connect the device to power.

• To put the device in power saving mode, press the power button while the device is on.
While in power saving mode, the screen is off and the device uses very little power, but it can wake instantly 
for use.
TIP: you can charge your device faster by putting it in power saving mode while charging the battery.

• To turn off the device completely, hold the power button until a prompt appears on the screen and select Off.
The prompt appears after five seconds. If you release the power button before the prompt appears, the 
device enters power saving mode.
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Acquiring GPS signals
When you turn on your navigation device, the GPS receiver must collect satellite data and establish the current 
location. The time required to acquire satellite signals varies based on several factors, including how far you are 
from the location where you last used your navigation device, whether you have a clear view of the sky, and how 
long it has been since you last used your navigation device. The first time you turn on your navigation device, it 
may take several minutes to acquire satellite signals.
1 Turn on the device.
2 Wait while the device locates satellites.
3 If necessary, go to an open area away from tall buildings and trees.

 in the status bar indicates the satellite signal strength. When at least half of the bars are filled, the device 
is ready for navigation.

Status bar icons
The status bar is located at the top of the main menu. The status bar icons display information about features 
on the device. You can select some icons to change settings or view additional information.

GPS signal status. Hold to view GPS accuracy and acquired satellite information (Viewing GPS 
signal status, page 67).

Bluetooth® technology status. Select to view the Bluetooth settings (Wireless network settings, 
page 57).

Wi-Fi signal strength. Select to change the Wi-Fi settings (Wireless network settings, page 57).

Connected to hands-free calling. Select to place a phone call (Hands-free calling, page 37).

Active vehicle profile. Select to view the vehicle profile settings (Editing a vehicle profile, page 8).

Garmin eLog™ status. Select to view the current ELD information. When the icon is blue, the device 
is connected to the Garmin eLog app.

Current time. Select to set the time (Setting the Time, page 59).

Battery charge level.

dēzl™ app connection status(Pairing with Your Smartphone, page 34).

Temperature. Select to view the weather forecast (Viewing the Weather Forecast, page 44).

Dash cam recording status. Select to open the dash cam controls.

Using the on-screen buttons
On-screen buttons allow you to navigate the pages, menus and menu options on your device.
• Select  to return to the previous menu screen.
• Hold  to quickly return to the main menu.
• Select  or  to scroll through lists or menus.
• Hold  or  to scroll faster.
• Select  to see a context-based menu of options for the current screen.
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Adjusting the volume
1 Select .
2 Select an option:

• Use the slider bar to adjust the volume.
• Select  to mute the device.
• Select a tick box to enable or disable additional sound options.

Using the audio mixer
You can use the audio mixer to set the volume levels for different audio types, such as navigation prompts or 
phone calls. The level for each audio type is a percentage of the master volume.
1 Select .
2 Select Mixer.
3 Use the sliders to adjust the volume for each audio type.

Enabling or Disabling Sounds and Audio Sources
You can turn specific audio sources and system sounds on or off without affecting other audio sources.
1 Select .
2 In the Sounds section, select an option:

• To enable the device to speak navigation prompts and directions, select the Spoken Navigation check 
box.

• To enable the device to say traffic alerts and prompts, select the Spoken Traffic Alerts check box.
• To enable the device to play a tone when a driver awareness alert is triggered, select the Alerts and Tones 

check box.
• To enable the device to play a sound when you touch on-screen buttons, select the Button Presses check 

box.

Adjusting the screen brightness
1 Select  > Display > Brightness.
2 Use the slider bar to adjust the brightness.

Vehicle Profiles
 WARNING

Entering your vehicle profile characteristics does not guarantee that your vehicle's characteristics will be 
accounted for in all route suggestions or that you will receive the warning icons in all cases. Limitations may 
exist in the map data such that your device cannot account for these restrictions or road conditions in all cases. 
Always defer to all posted road signs and road conditions when making driving decisions.

Routing and navigation are calculated differently based on your vehicle profile. The activated vehicle profile 
is indicated by an icon in the status bar. The navigation and map settings on your device can be customised 
separately for each vehicle type.
When you activate a lorry vehicle profile, the device avoids including restricted or impassable areas in routes 
based on the dimensions, weight, and other characteristics you entered for your vehicle.
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Adding a vehicle profile
You can add a vehicle profile that includes the weight, dimensions, and other characteristics for your vehicle.
1 Select  > Vehicle Profile > .
2 Select an option:

• To add a straight lorry with a permanently attached cargo area, select Straight Lorry.
• To add a tractor or a tractor-trailer combination, select Articulated Lorry.
• To add a bus, select Bus.

3 Follow the on-screen instructions to enter the vehicle characteristics.
After you add a vehicle profile, you can edit the profile to enter additional detailed information, such as the 
vehicle identification number or trailer number (Editing a vehicle profile, page 8).

Adding an environmental zone vehicle profile
You can add a vehicle profile for the environmental zone settings specific to your vehicle, such as fuel type and 
emission standard.
NOTE: this feature is not available for all regions or product models.
1 Select  > Navigation > Environmental Zones.
2 Follow the on-screen instructions.

Car Profile
The car profile is a preloaded vehicle profile intended for use in an automobile without a trailer. While using 
the car profile, the device calculates standard automobile routes, and routing for large vehicles is not available. 
Some features and settings specific to large vehicles are not available while using the car profile.

Switching the Vehicle Profile
Each time you turn on your device, it prompts you to select a vehicle profile. You can manually switch to another 
vehicle profile at any time.
1 From the status bar, select the vehicle profile icon, such as  or .
2 Select a vehicle profile.

The vehicle profile information appears, including measurements and weight.
3 Select Select.

Changing your trailer information
Before you can change your trailer information, you must enter a vehicle profile for a tractor (Adding a vehicle 
profile, page 7).
When you change the trailer on your lorry, you can change the trailer information in your vehicle profile without 
changing the lorry information. You can switch quickly between frequently used trailers.
1 From the home screen, select the vehicle profile widget.
2 Select the lorry vehicle profile to use with the trailer.
3 Select .
4 Select an option:

• To use a recent trailer configuration, select a trailer configuration from the list.
• To enter a new trailer configuration, select New Configuration and enter the trailer information.
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Editing a vehicle profile
You can edit a vehicle profile to change vehicle information or to add detailed information to a new vehicle 
profile, such as the vehicle identification number, trailer number or odometer reading. You can also rename or 
delete a vehicle profile.
1 Select  > Vehicle Profile.
2 Select the vehicle profile to edit.
3 Select an option:

• To edit the vehicle profile information, select , and select a field to edit.
• To rename a vehicle profile, select  >  > Rename Profile.
• To delete the vehicle profile, select  >  > Delete.

Dash Cam
Aligning the camera

 WARNING
Do not attempt to align the camera while driving because doing so can cause distraction that could lead to an 
accident resulting in serious personal injury or death.

Advanced driver assistance features may not perform properly if the camera is not aligned. You should align the 
dash camera each time you mount or reposition the device.
1 Select  > Dash Cam > Camera placement.
2 Select Horizontal Placement, and select the horizontal location of your device on the windscreen.
3 Select Vehicle Height, and select your vehicle type.
4 Select Alignment.
5 Tilt the device and turn the camera left or right to align the camera.

The camera should point straight ahead, and the horizon should be centred between the top and bottom of 
the screen.

Dash Cam Recording
NOTICE

Some jurisdictions may prohibit or regulate recording audio and video or taking photographs. Jurisdictions 
may require that all parties have knowledge of the recording and provide consent before you record audio and 
video or take photographs. It is your responsibility to know and comply with all laws, regulations and any other 
restrictions in your jurisdiction.

The dash cam records video to the camera memory card. By default, the device immediately starts recording 
video when it turns on, and it continues recording until it is turned off. If the memory card is full, the device 
automatically deletes the oldest unsaved video to create space for new video.
When the option to promptly delete unsaved video is enabled, the device continually deletes unsaved video 
more than three minutes old and deletes all unsaved video each time it is powered off. You can enable or 
disable this feature in the camera settings (Dash Cam Settings, page 58).
You can save a video recording to prevent it from being overwritten or deleted.
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Saving a Dash Cam Recording
You can save a portion of the recorded video to prevent it from being overwritten by new video. By default, the 
device uses a sensor to detect possible accidental collisions and saves video footage before, during and after 
the detected event. You can also manually save video at any time. 
1 While the dash cam is recording, select Dash Cam > .

The device saves the video footage before, during and after you select .
2 Select  again to extend the saved recording time (optional).

A message indicates the video is saving.

Stopping or starting dash camera recording
1 Select Dash Cam.
2 Select an option:

• To stop recording, select .
TIP: by default, recording starts automatically the next time you turn on the device. You can disable this 
option in the camera settings (Dash Cam Settings, page 58).

• To start recording, select .

Turning audio recording on or off
NOTICE

Some jurisdictions may prohibit recording audio in the vehicle or may require that all passengers have 
knowledge of the recording and provide consent before you record audio in the vehicle. It is your responsibility 
to know and follow all laws and restrictions for your jurisdiction.

The device can record audio using the integrated microphone whilst recording video. You can turn audio 
recording on or off at any time.

Select  > Dash Cam > Record Audio.

Viewing videos and photos
NOTE: the device stops recording video while you view videos or photos.
1 Select Gallery > Yes.
2 Select a video or photo.

The device displays the video or photo. Videos start playing automatically. If the video or photo includes 
location information, a map shows the location.

Videos on Your Computer
Media is stored in the DCIM folder on the camera memory card. Videos are stored in MP4 file format.Photos are 
stored in JPG format. You can view and transfer media by connecting the memory card or the device to your 
computer (Connecting the Device to Your Computer, page 65).
The media is sorted into several folders.
100EVENT: contains videos saved automatically when the device detected an incident.
101PHOTO: contains photos.
102SAVED: contains videos saved manually by the user.
105UNSVD: contains unsaved video footage. The device overwrites the oldest unsaved video when the storage 

space for unsaved video is full.

Deleting a video or photo
1 Select Gallery > Yes.
2 Select a video or photo.
3 Select  > Yes.
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Vault Storage
NOTE: this feature is not available for all countries.
You can upload, manage and share dash camera footage on a secure, online storage drive using the Vault. The 
dash camera uploads saved videos to the Vault automatically while it is connected to a Wi‑Fi® network.
You can store videos in the Vault for up to 24 hours with your dēzl account. There is no size limit to the amount 
of data you can store. You can purchase an optional Vault subscription from the dēzl app on your smartphone 
to extend your storage time.
NOTE: your dash camera must be connected to a Wi‑Fi network to use this feature.

Upgrading Your Vault Subscription
You can purchase an optional Vault subscription to extend your storage time.
1 From the dēzl app on your smartphone, select  > Vault Access > Need More Time?.
2 Follow the on-screen instructions.

Sharing a Video
You can share a secure link to a dash camera video from the Vault.
1 From the dēzl app on your smartphone, select Vault.
2 Select a video, and select Secure share.
3 Follow the on-screen instructions.

Editing and Exporting a Video
You can trim the length of your video to remove unnecessary footage before exporting it to the Vault.
1 While viewing a video, drag the trimming handles  on the video progress bar left or right to trim the video 

length.

2 Select the Include Audio tick box to include the recorded audio (optional).
3 Select  or select Export.

NOTE: you must keep the app in the foreground while exporting a video.
The app exports the trimmed video to the Vault and saves the video to your smartphone.

4 After the video export is complete, select an option (optional):
• To remove the video from the camera memory card, select Remove From Camera.
• To return to the gallery, select  or select Done.

Disabling a Shared Video Link
You can disable a link to a video that you previously shared from the Vault. When you disable a shared video 
link, the video is set to private and the shared link and passcode are disabled.
1 From the dēzl app on your smartphone, select Vault.
2 Select a video, and select Disable Link > Continue.
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Removing a Video from the Vault
1 From the dēzl app on your smartphone, select Vault.
2 Select a video, and select Remove From {0} > Continue.

Driver awareness features and alerts
 CAUTION

The driver alerts and speed limit features are for information only. They do not replace your responsibility to 
abide by all posted speed limit signs and to use safe driving judgement at all times. Garmin® is not responsible 
for any traffic fines or citations that you receive for failing to follow all applicable traffic laws and signs.

Your device provides features that can help encourage safer driving and increase efficiency, even when you are 
driving in a familiar area. The device plays an audible tone or message and displays information for each alert. 
You can enable or disable the audible tone for some types of driver alerts. Not all alerts are available in all areas.
Schools: the device plays a tone and displays the speed limit (if available) for an upcoming school or school 

zone.
Speed limit exceeded: the device displays a red border on the speed limit icon when you exceed the posted 

speed limit for the current road.
Speed limit reduced: the device plays a tone and displays the upcoming speed limit so you can be prepared to 

adjust your speed.
Wrong way on a one-way street: the device plays a message and displays a full-screen warning if you travel the 

wrong way on a one-way street. The edges of the screen appear red and an alert remains at the top of the 
screen until you leave the one-way street or correct your direction of travel.

Level crossing: the device displays the distance to an upcoming railway crossing.
Animal crossing: the device plays a tone to indicate an upcoming animal crossing area.
Bends: the device plays a tone to indicate a bend in the road.
Slower traffic: the device plays a tone to indicate slower traffic when you approach slower traffic at a higher 

speed. Your device must be receiving traffic information to use this feature (Traffic, page 39).
Construction zone: the device plays a tone and displays a message when you approach a construction zone.
Lane closure: the device plays a tone and displays a message when you approach a lane closure.
Break planning: the device plays a tone and suggests upcoming rest stops after you have been driving for a 

long time.
No lorries allowed: the device plays a tone when you approach a road where no lorries are allowed.
Risk of grounding: the device plays a tone and displays a message when you approach a road where your 

vehicle could become grounded.
Lateral wind: the device plays a tone and displays a message when you approach a road where there is risk of 

lateral wind.
Narrow road: the device plays a tone and displays a message when you approach a road that may be too narrow 

for your vehicle.
Steep hill: the device plays a tone and displays a message when you approach a steep hill.
County and country borders: the device plays a tone and displays a message when you approach the border of 

a county or country.
Forward collision warning: the device alerts you when it detects that there is not a safe distance between your 

vehicle and the vehicle in front of you.
Lane departure warning: the device alerts you when it detects you may be crossing a lane boundary 

unintentionally.
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Enabling or Disabling Driver Alerts
You can enable or disable several types of driver alerts.
1 Select  > Driver Assistance > Driver Alerts.
2 Select or clear the tick box next to each alert.

Red light and speed cameras
NOTICE

Garmin is not responsible for the accuracy of or the consequences of using a red light or speed camera 
database.

NOTE: this feature is not available for all regions or product models.
Information about red light and speed camera locations is available in some areas for some product models. 
The device alerts you when you approach a reported speed or red light camera.
• In some areas, your device can receive red light and speed camera data while connected to a smartphone 

running the dēzl app.
• You can use the Garmin Express™ software (garmin.com/express) to update the camera database stored on 

your device. You should update your device frequently to receive the most up-to-date camera information.

Advanced Driver Assistance System
Your device includes an advanced driver assistance system (ADAS), which uses the integrated dash camera to 
provide warnings and alerts about your driving environment.
You can enable or disable each of the advanced driver assistance features in the Driver Assistance settings 
(Driver Assistance Settings, page 57).

Forward collision warning system
 WARNING

The forward collision warning system (FCWS) feature is for information only and does not replace your 
responsibility to observe all road and driving conditions, abide by all traffic regulations, and use safe driving 
judgement at all times. The FCWS relies on the camera to provide a warning of upcoming vehicles and, as 
a result, may have limited functionality in low visibility conditions. For more information, go to garmin.com
/warnings.

The FCWS feature alerts you when the device detects that there is not a safe distance between your vehicle 
and the vehicle in front of you. The device determines your vehicle speed using GPS, and it calculates an 
estimated safe following distance based on your speed. The FCWS activates automatically when your vehicle 
speed exceeds 65 km/hr (40 mph).
When the device detects that you are too close to the vehicle in front of you, the device plays an audible alert 
and a warning appears on the screen.
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Forward collision warning system performance tips
Several factors affect the performance of the forward collision warning system (FCWS). Some conditions may 
prevent the FCWS feature from detecting a vehicle in front of you.
• The FCWS feature activates only when your vehicle speed exceeds 65 km/h (40 mph).
• The FCWS feature may not detect a vehicle in front of you when the camera's view of the vehicle is obscured 

by rain, fog, snow, sun or headlight glare, or darkness.
• The FCWS feature may not function properly if the camera is incorrectly aligned .
• The FCWS feature may not detect vehicles farther away than 40 m (130 ft.) or closer than 5 m (16 ft.).
• The FCWS feature may not function properly if the camera placement settings do not correctly indicate your 

vehicle height or the placement of your device in the vehicle .

Lane departure warning system
 WARNING

The lane departure warning system (LDWS) feature is for information only and does not replace your 
responsibility to observe all road and driving conditions, abide by all traffic regulations, and use safe driving 
judgement at all times. The LDWS relies on the camera to provide warnings for lane markers and, as a result, 
may have limited functionality in low visibility conditions. For more information, go to garmin.com/warnings.

The LDWS feature alerts you when the device detects you may be crossing a lane boundary unintentionally. For 
example, the device alerts you if you cross some solid painted lane boundaries. The LDWS feature provides 
alerts only when your vehicle speed exceeds 65 km/h (40 mph). The alert appears on the left or right side of the 
screen to indicate which lane boundary you crossed.

NOTE: for the best LDWS performance, you should set the Camera placement option to indicate the location of 
the device in your vehicle.

Setting the camera placement
You can mount the device in the left, centre or right of your windscreen or dashboard. for the best LDWS 
performance, you should set the Camera placement option to indicate the location of your device in the vehicle.
1 Select  > Dash Cam > Camera placement > Horizontal Placement.
2 Select the location of the device.
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Lane departure warning performance tips
Several factors affect the performance of the lane departure warning system (LDWS). Some conditions may 
prevent the LDWS feature from detecting lane departures.
• The LDWS feature provides alerts only when your vehicle speed exceeds 65 km/h (40 mph).
• The LDWS feature may not function properly if the camera is incorrectly aligned.
• The LDWS feature may not function properly if the camera placement settings do not correctly indicate your 

vehicle height or the placement of your device in the vehicle .
• The LDWS feature requires a clear, continuous view of the lane divider lines.

◦ Lane departures may not be detected when divider lines are obscured by rain, fog, snow, extreme 
shadows, sun or headlight glare, road construction, or any other visual obstruction.

◦ Lane departures may not be detected if lane divider lines are misaligned, missing or heavily worn.
• The LDWS feature may not detect lane departures on extremely wide, narrow or winding roads.

Finding and saving locations
The maps loaded in your device contain locations, such as restaurants, hotels, vehicle services, and detailed 
street information. The Where To? menu helps you find your destination by providing several methods to 
browse, search, and save this information.
From the main menu, select Where To?.
• To quickly search all locations on your device, select Search (Finding a location using the search bar, 

page 15).
• To find an address, select Address (Finding an address, page 15).
• To browse or search pre-loaded points of interest by category, select Categories (Finding a location by 

category, page 18).
• To search near a different town or area, select  next to the current search area (Changing the search area, 

page 17).
• To view and edit your saved locations, select Favourites (Saving Locations, page 21).
• To view locations you have recently selected from the search results, select History.
• To search for lorry stops and services, select Categories > Lorry Use (Finding lorry use points of interest, 

page 17).
• To browse and search Tripadvisor® traveller ratings, select Tripadvisor.
• To navigate to specific geographic coordinates, select Coordinates (Finding a location using coordinates, 

page 19).
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Finding a location using the search bar
You can use the search bar to search for locations by entering a category, brand name, address or town name.
1 Select Where To?.
2 Select Search in the search bar.
3 Enter all or part of the search term.

Suggested search terms appear below the search bar.
4 Select an option:

• To search for a type of business, enter a category name (for example, "cinemas").
• To search for a business name, enter all or part of the name.
• To search for an address near you, enter the house number and street name.
• To search for an address in another town, enter the house number, street name, town and county.
• To search for a town, enter the town and county.
• To search for coordinates, enter latitude and longitude coordinates.

5 Select an option:
• To search using a suggested search term, select the term.
• To search using the text you entered, select .

6 If necessary, select a location.

Finding an address
NOTE: the order of the steps may change depending on the map data loaded on your device.
1 Select Where To?.
2 If necessary, select  to search near a different town or area.
3 Select Address.
4 Follow the on-screen instructions to enter address information.
5 Select the address.
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Location Search Results
The location search results appear in a list, with the nearest location at the top. Each numbered location also 
appears on the map. You can scroll down to view more results.

Select a location to view the option menu.

 Select to view detailed information about the location.

 Go! Select to start navigating to the location using the recommended route.

 Plan Arrival Select to view a map of your destination and find a lorry destination.
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Changing the search area
By default, the device searches for locations near your current location. You can also search other areas, such 
as near your destination, near another city, or along your active route.
1 Select Where To?.
2 Select  next to the current search area .

3 Select a search area.
4 If necessary, follow the on-screen instructions to select a specific location.
The selected search area appears next to . When you search for a location using any of the options in the 
Where To? menu, the device suggests locations near this area first.

Points of Interest
NOTICE

You are responsible for understanding and complying with any applicable rules, laws or regulations associated 
with points of interest.

A point of interest is a place that you may find useful or interesting. Points of interest are organised by category 
and can include popular travel destinations such as petrol stations, restaurants, hotels, and entertainment 
venues.

Finding lorry use points of interest
NOTICE

You are responsible for understanding and complying with any applicable rules, laws or regulations associated 
with points of interest.

The detailed maps loaded on your device contain lorry use points of interest, such as motorway services, 
roadside services and weighbridges.

Select Where To? > Categories > Lorry Use.

Finding TruckDown® points of interest
The TruckDown directory lists businesses for the haulage industry such as lorry repair and tyre sales.
The TruckDown directory is available only in North America.
1 Select Where To?.
2 Select an option:

• Select Truck Locations to find points of interest compatible with lorries.
• Select Truck Services to find service locations for your lorry.

3 Select a category.
4 If necessary, select Filter by Amenities & Brands, select one or more amenities and select Save.

NOTE: this option is available for motorway services only.
5 Select a destination.
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Finding a location by category
1 Select Where To?.
2 Select a category or select Categories.
3 If necessary, select a subcategory.
4 Select a location.

Searching within a category
After you have performed a search for a point of interest, certain categories may display a Quick Search list that 
displays the last four destinations you selected.
1 Select Where To? > Categories.
2 Select a category.
3 Select an option:

• Select a destination from the quick search list on the right side of the screen.
The quick search list provides a list of recently found locations in the selected category.

• Select a subcategory, if necessary, and select a destination.

Tripadvisor
NOTICE

Garmin is not responsible for the accuracy or timeliness of the Tripadvisor information.
You are responsible for understanding and complying with any applicable rules, laws or regulations associated 
with points of interest.

Your device includes Tripadvisor traveller ratings. Tripadvisor ratings appear automatically in the search results 
list for restaurants, hotels and attractions. You can also search for nearby Tripadvisor points of interest and sort 
by distance or popularity.

Finding Tripadvisor points of interest
1 Select Where To? > Tripadvisor.
2 Select a category.
3 If necessary, select a subcategory.

A list of nearby Tripadvisor points of interest for the category appears.
4 Select Sort Results to filter the displayed points of interest by distance or popularity (optional).
5 Select , and enter a search term (optional).

Navigating to points of interest within a venue
NOTE: this feature may not be available in all areas or for all product models.
You can create a route to a point of interest (POI) within a larger venue, such as a store in a shopping centre or a 
specific terminal in an airport.
1 Select Where To? > Search.
2 Enter the name of the venue and select .
3 Select the venue.

A list of categories for POIs within the venue appears.
4 Select a category, select a location and select Go!.
The device creates a route to the parking area or venue entrance closest to the POI. When you arrive at the 
destination, a chequered flag indicates the recommended parking area. A labelled point indicates the location of 
the POI within the venue.

Custom points of interest
Custom POIs are customised points on the map. They can contain alerts that let you know if you are near a 
designated point or if you are travelling faster than a specified speed.
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Installing POI Loader
You can create or download custom POI lists on your computer and install them on your device using POI 
Loader software.
1 Go to www.garmin.com/poiloader.
2 Follow the on-screen instructions.

Finding custom POIs
Before you can find custom POIs, you must load custom POIs on your device using the POI Loader software 
(Installing POI Loader, page 19).
1 Select Where To? > Categories.
2 Scroll to the Other Categories section, and select a category.

Search tools
Search tools allow you to search for specific types of locations by responding to on-screen prompts.

Finding a junction
You can search for a junction between two streets, motorways, or other roads.
1 Select Where To? > Junctions.
2 Follow the on-screen instructions to enter street information.
3 Select the junction.

Finding a location using coordinates
You can find a location using latitude and longitude coordinates.
1 Select Where To? > Coordinates.
2 If necessary, select , and change the coordinate format or datum.
3 Select Coordinates.
4 Enter the latitude and longitude coordinates, and select Done.
5 Select an option:

• To save the coordinates as a location, select Save.
• To start a route to the coordinates, select Go!.

Parking

Finding lorry parking
1 Select Where To? > Truck Locations > Parking.
2 If necessary, select High Capacity Only to filter locations by parking capacity.
3 Select a parking location.
4 Select Go!.

Finding Lorry Parking in Europe
If you pair your dēzlCam device with the dēzl app and log in to your Truck Parking Europe account, you can view 
parking availability and ratings on your navigation device.
NOTE: this feature is available only in Europe.
1 Select Where To? > Truck Parking Europe.
2 If necessary, select Filter by Amenities & Brands, select one or more attributes and select Search.
3 Select a parking location.
4 Select Go!.
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Finding Parking Near Your Current Location
1 Select Where To? > Categories > Parking.
2 Select a parking location.
3 Select Go!.

Finding Parking Near a Specified Location
NOTE: this feature is available only when you are using the car vehicle profile.
1 Select Where To?.
2 Search for a location.
3 From the location search results, select a location.
4 Select .

A list of parking areas near the selected location appears.
5 Select a parking location.
6 Select Go!.

Viewing history
Your device stores a history of the last 50 locations you have found.

Select Where To? > History.

Clearing the list of recently found places
Select Where To? > History >  > Clear > Yes.

Viewing current location information
You can use the Where Am I? page to view information about your current location. This feature is helpful if you 
need to tell emergency personnel your location.

From the map, select the vehicle.

Finding emergency services and fuel
You can use the Where Am I? page to find the nearest hospitals, police stations, and fuel stations.
1 From the map, select the vehicle.
2 Select Hospitals, Police Station, or Petrol Stations.

NOTE: when a lorry vehicle profile is active, an option for motorway services appears instead of fuel.
A list of locations for the selected service appears, with the nearest locations at the top.

3 Select a location.
4 Select an option:

• To navigate to the location, select Go!
• To view the phone number and other location details, select .

Getting directions to your current location
If you need to tell another person how to get to your current location, your device can give you a list of 
directions.
1 From the map, select the vehicle.
2 Select  > Directions to Me.
3 Select a starting location.
4 Select Select.
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Saving Locations

Saving a location
1 Search for a location (Finding a location by category, page 18).
2 From the search results, select a location.
3 Select  > Save.
4 If necessary, enter a name, and select Done.
5 Select Save.

Saving your current location
1 From the map, select the vehicle icon.
2 Select Save.
3 Enter a name and select Done.

Editing a Saved Location
1 Select Where To? > Favourites.
2 If necessary, select a category.
3 Select a location.
4 Select .
5 Select  > Edit.
6 Select an option:

• Select Name.
• Select Phone Number.
• Select Categories to assign categories to the saved location.
• Select Change Map Symbol to change the symbol used to mark the saved location on a map.

7 Edit the information.
8 Select Done.

Assigning Categories to a Saved Location
You can add custom categories to organise your saved locations.
NOTE: categories appear in the saved locations menu after you have saved more than 12 locations.
1 Select Where To? > Favourites.
2 Select a location.
3 Select .
4 Select  > Edit > Categories.
5 Enter one or more category names, separate by commas.
6 If necessary, select a suggested category.
7 Select Done.

Deleting a favourite location
NOTE: deleted locations cannot be recovered.
1 Select Where To? > Favourites.
2 Select  > Delete.
3 Select the box next to the favourite locations to delete and select Delete > Yes.
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Navigating to your destination
Routes
A route is a path from your current location to one or more destinations.
• The device calculates a recommended route to your destination based on the preferences you set, including 

the route calculation mode (Changing the route calculation mode, page 27) and avoidances (Avoiding Delays, 
Tolls and Areas, page 27).

• The device can automatically avoid roads that are not appropriate for the active vehicle profile.
• You can start navigating to your destination quickly using the recommended route, or you can select an 

alternative route (Starting a route, page 22).
• If there are specific roads you need to use or avoid, you can customise the route (Shaping Your Route, 

page 26).
• You can add multiple destinations to a route (Adding a location to your route, page 26).

Starting a route
1 Select Where To?, and search for a location (Finding and saving locations, page 14).
2 Select a location.
3 Select an option:

• To start navigating using the recommended route, select Go!.
• To choose an alternative route, select , and select a route.

Alternative routes appear to the right of the map.
• To edit the course of the route, select  > Edit Route, and add shaping points to the route (Shaping Your 

Route, page 26).
The device calculates a route to the location and guides you using voice prompts and information on the map 
(Your route on the map, page 23). A preview of the major roads in your route appears at the edge of the map for 
several seconds.
If you need to stop at additional destinations, you can add the locations to your route (Adding a location to your 
route, page 26).

Starting a route by using the map
You can start a route by selecting a location from the map.
1 Select View Map.
2 Drag and zoom the map to display the area to search.
3 Select an option:

• Select a location marker.
• Select a point, such as a street, junction or address location.

4 Select Go!.

Going home
The first time you start a route home, the device prompts you to enter your home location.
1 Select Where To? > Go Home.
2 If necessary, enter your home location.

Editing your home location
1 Select Where To? >  > Set Home Location.
2 Enter your home location.
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Your route on the map
As you travel, the device guides you to your destination using voice prompts and information on the map. 
Instructions for your next turn or exit, or other actions appear across the top of the map.

Next action in the route. Indicates the next turn, exit, or other action and the lane in which you should 
travel, if available.

Distance to the next action.

Name of the street or exit associated with the next action.

Route highlighted on the map.

Next action in the route. Arrows on the map indicate the location of upcoming actions.

Vehicle speed.

Name of the road on which you are travelling.

Estimated arrival time.
TIP: you can touch this field to change the information it shows (Changing the map data field, page 33).

Map tools. Provides tools to show you more information about your route and surroundings.

Select to toggle popular lorry routes on the map.

Select to search for lorry stops and other locations along your route.
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Viewing Popular Lorry Paths on the Map
You can enable the device to highlight popular lorry paths on the map. This can be useful to help you choose 
roads that are more accessible for your vehicle.

From the map, select .

Active lane guidance
As you approach some turns, exits, or interchanges in your route, a detailed simulation of the road appears 
beside the map, if available. A coloured line  indicates the proper lane for the turn.

Viewing turns and directions
While navigating a route, you can view next turns, lane changes, or other directions for your route.
1 From the map, select an option:

• To view next turns and directions as you navigate, select  > Turns.
The map tool displays the next several turns or directions beside the map. The list updates automatically 
as you navigate the route.

• To view the complete list of turns and directions for the entire route, select the text bar at the top of the 
map.

2 Select a turn or direction (optional).
Detailed information appears. An image of the junction may appear for junctions on major roads, if available.

Viewing the Entire Route on the Map
1 While navigating a route, select anywhere on the map.
2 Select .

Planning Your Arrival
Before you start a route, you can plan to arrive at a popular lorry destination, such as a loading dock or lorry 
parking, at the end of your route. You can also add your own destinations to the map.
1 Select Where To?, and search for a location (Finding and saving locations, page 14).
2 Select a location.
3 Select Plan Arrival.

A preview of your destination appears on the map. Popular lorry destinations appear next to the map. If your 
dēzlCam device is paired with the dēzl app, it downloads BirdsEye satellite imagery automatically.

4 Select a destination and select Go!.
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Arriving at your destination
When you approach your destination, the device provides information to help you complete your route.
•  indicates the location of your destination on the map, and a voice prompt announces you are approaching 

your destination.
• When you approach some destinations, the device automatically suggests parking areas. You can select 

More to view a full list of suggested parking areas (Parking Near Your Destination, page 26).
• When you approach some destinations while using a lorry vehicle profile, the device automatically prompts 

you to find a lorry destination such as a loading dock or lorry parking. You can select a suggested point on 
the map and then select Go! to navigate to that destination.

• When you stop at your destination, the device automatically ends the route. If the device does not detect your 
arrival automatically, you can select  > Stop to end your route.

Completing a Lorry Route
When you approach some lorry destinations, a map tool appears to help you find common lorry destinations 
such as parking areas and loading docks.
1 Select the map tool .

2 Touch the map, and select a numbered lorry use destination .
3 Select Go!.
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Parking Near Your Destination
Your device can help you find a parking spot near your destination. When you approach some destinations, the 
device automatically suggests parking areas.
NOTE: this feature should be used only when you are using the car vehicle profile. While using a lorry vehicle 
profile, you can search for lorry parking near your destination (Finding lorry parking, page 19).
1 Select an option:

• When the device suggests parking, select More to see all suggested parking areas.
NOTE: when you select a suggested parking area, the device automatically updates your route.

• If the device does not suggest parking locations, select Where To? > Categories > Parking, and select  > 
My Destination.

2 Select a parking location and select Go!.
The device guides you to the parking area.

Changing Your Active Route

Adding a location to your route
Before you can add a location to your route, you must be navigating a route (Starting a route, page 22).
You can add locations to the middle or end of your route. For example, you can add a petrol station as the next 
destination in your route.
1 From the map, select  > Where To?.
2 Search for a location (Finding and saving locations, page 14).
3 Select a location.
4 Select Go!.
5 Select an option:

• To add the location as the next destination in your route, select Add as Next Stop.
• To add the location to the end of your route, select Add as Last Stop.Add as Last Stop
• To add the location and edit the order of destinations in your route, select Add to Active Route.

The device re-calculates the route to include the added location and guides you to the destinations in order.

Shaping Your Route
Before you can shape your route, you must start a route (Starting a route, page 22).
You can manually shape your route to change its course. This allows you to direct the route to use a certain 
road or go through a certain area without adding a destination to the route.
1 From the map, select  > Edit Route > Shape Route.

TIP: you can select  to zoom in on the map and select a more precise location.
The device enters route-shaping mode and recalculates the route to travel through the selected location.

2 Select  > .
3 If necessary, select an option:

• To add more shaping points to the route, select additional locations on the map.
• To remove a shaping point, select the shaping point and select .

Taking a detour
You can take a detour for a specified distance along your route or detour around specific roads. This is useful if 
you encounter construction zones, closed roads or poor road conditions.
1 From the map, select  > Edit Route.
2 Select an option:

• To re-route for a specific distance, select Detour by Distance.
• To detour around a specific road on the route, select Detour by Road.

26 Navigating to your destination



Changing the route calculation mode
1 Select  > Navigation > Calculation Mode.
2 Select an option:

• Select Faster Time to calculate routes that are faster to drive, but can be longer in distance.
• Select Off Road to calculate point-to-point routes (without roads).

Stopping the route
From the map, select  > Stop.

Using Suggested Routes
Before you can use this feature, you must save at least one location and enable the travel history feature (Device 
and privacy settings, page 59).
Using the myTrends™ feature, your device predicts your destination based on your travel history, the day of the 
week and the time of day. After you have driven to a favourite location several times, the location may appear in 
the navigation bar on the map, along with the estimated time of travel and traffic information.

Select the navigation bar to view a suggested route to the location.

Avoiding Delays, Tolls and Areas

Avoiding traffic delays on your route
Before you can avoid traffic delays, you must be receiving traffic information.
By default, the device optimises your route to avoid traffic delays automatically. If you have disabled this option 
in the traffic settings (Traffic Settings, page 58), you can view and avoid traffic delays manually.
1 While navigating a route, select  > Traffic.
2 Select Alternative Route, if available.
3 Select Go!.

Avoiding road features
1 Select  > Navigation > Avoidances.
2 Select the road features to avoid on your routes and select Save.

Avoiding environmental zones on your route
Your device can avoid areas with environmental or emissions restrictions that may apply to your vehicle.
Before you can use this feature, you must add an environmental zone vehicle profile to your device (Adding an 
environmental zone vehicle profile, page 7).
Before you can avoid environmental zones on your route, you must start a route.
NOTE: this feature is not available for all regions or product models.

When the device prompts you, select Go! to take an alternative route.

Custom Avoidances
Custom avoidances allow you to select specific areas or sections of road to avoid. When the device calculates a 
route, it avoids these areas and roads unless no other reasonable route is available.
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Avoiding a road
1 Select  > Navigation > Custom Avoidances.
2 If necessary, select Add Avoidance.
3 Select Add Avoid Road.
4 Select the starting point of the section of road to avoid and select Next.
5 Select the ending point of the road section and select Next.
6 Select Done.

Avoiding an area
1 Select  > Navigation > Custom Avoidances.
2 If necessary, select Add Avoidance.
3 Select Add Avoid Area.
4 Select the upper left corner of the area to avoid and select Next.Next
5 Select the lower right corner of the area to avoid and select Next.Next

The selected area is shaded on the map.
6 Select Done.

Disabling a custom avoidance
You can disable a custom avoidance without deleting it.
1 Select  > Navigation > Custom Avoidances.
2 Select a created avoidance.
3 Select  > Disable.

Deleting custom avoidances
1 Select  > Navigation > Custom Avoidances > .
2 Select an option:

• To delete all custom avoidances, select Select All > Delete.
• To delete one custom avoidance, select the avoidance and select Delete.

Using the Map
You can use the map to navigate a route (Your route on the map, page 23) or to view a map of your surroundings 
when no route is active.
1 Select View Map.
2 Select anywhere on the map.
3 Select an option:

• Drag the map to pan left, right, up, or down.
• To zoom in or out, select  or .
• To switch between North Up, 2D and 3D views, select .
• To open the route planner, select  (Route Planner, page 45).
• To start a route, select a location on the map and select Go! (Starting a route by using the map, page 22).
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Map tools
Map tools provide quick access to information and device functions while you view the map. When you activate 
a map tool, it appears in a panel at the edge of the map.
Stop: stops navigation of the active route.
Camera: provides dash cam controls and displays forward collision and lane departure alerts. Also allows you 

to open the dash cam viewfinder and the driver assistance settings.
Edit Route: allows you to re-route or skip locations in your route (Changing Your Active Route, page 26).
Mute: mutes the device audio.
Towns Ahead: displays upcoming towns and services along your active route or along a motorway (Towns 

Ahead, page 30).
Up Ahead: displays upcoming locations along the route, or the road on which you are travelling (Up ahead, 

page 29).
Elevation: displays upcoming elevation changes.
Traffic: displays traffic conditions along your route or in your area (Viewing upcoming traffic, page 33). This 

feature is not available in all areas or for all device models.
Trip Data: displays customisable trip data, such as speed or mileage (Viewing trip data from the map, page 32).
Turns: displays a list of upcoming turns in your route (Viewing turns and directions, page 24).
Phone: displays a list of recent phone calls from your connected phone and displays in-call options while a 

phone call is active (Using in-call options, page 38).
Weather: displays weather conditions for your area.
Garmin eLog: displays hours of service information from the Garmin eLog app..
Music Controls: displays media controls and media information.
PrePass ®: shows notifications for upcoming weighbridges and bypass decisions(PrePass®, page 44).
Plan Arrival: displays a map of your destination and allows you to find a lorry destination.
Love's: displays upcoming Love's Travel Stops® along your route.

NOTE: this feature is only available in North America.
Pilot Flying J: displays upcoming Pilot Flying J Travel Centers™ along your route.

NOTE: this feature is only available in North America.
Break Planner: displays daily hours driven, total hours driven and the time to your next break.

Viewing a map tool
1 From the map, select .
2 Select a map tool.

The map tool appears in a panel at the edge of the map.
3 When you have finished using the map tool, select .

Up ahead
The Up Ahead tool provides information about upcoming locations along your route or the road on which you 
are travelling. You can view upcoming points of interest by category, such as restaurants, fuel stations or 
roadside services.
You can customise the categories that show in the Up Ahead tool.
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Viewing upcoming locations
1 From the map, select  > Up Ahead.

While you are travelling, the map tool shows the next location along your road or route.
2 Select an option:

• If the map tool shows categories, select a category to view a list of nearby locations in that category.
• If the map tool shows upcoming locations, select a location to view location details or start a route to the 

location.

Customising the up ahead categories
You can change the location categories that appear in the Up Ahead tool.
1 From the map, select  > Up Ahead.
2 Select a category.
3 Select .
4 Select an option:

• To move a category up or down in the list, select and drag the arrow next to the category name.
• To change a category, select the category.
• To create a custom category, select a category, select Custom Search and enter the name of a business 

or category.
5 Select Save.

Towns Ahead
While you are travelling on a highway or navigating a route that includes a highway, the Towns Ahead tool 
provides information about upcoming towns along the highway. For each town, the map tool shows the 
distance to the highway exit and the services available, similar to the information on highway road signs.

Viewing Upcoming Towns and Exit Services
1 From the map, select  > Towns Ahead.

While you are travelling along a motorway or an active route, the map tool shows information about 
upcoming towns and exits.

2 Select a town.
The device shows a list of points of interest located at the selected town exit, such as fuel stations, lodging 
or restaurants.

3 Select a location, and select Go! to start navigating.

Warning and alert symbols
 WARNING

Entering your vehicle profile characteristics does not guarantee that your vehicle's characteristics will be 
accounted for in all route suggestions or that you will receive the warning icons in all cases. Limitations may 
exist in the map data such that your device cannot account for these restrictions or road conditions in all cases. 
Always defer to all posted road signs and road conditions when making driving decisions.

Warning and alert symbols may appear on the map or in route directions to alert you to potential hazards, road 
conditions, and upcoming weighbridges.
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Restriction warnings

Height

Weight

Axle Weight

Length

Width

No Lorries Allowed

No Trailers Allowed

Material Restrictions

No Flammables or Explosives Allowed

No Water Pollutants Allowed

No Left Turn

No Right Turn

No U-Turn

Road condition warnings

Risk of grounding

Lateral wind

Narrow road

Sharp curve

Steep downhill

Steep uphill

Tree overhang
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Alerts

Weighbridge

Road not verified for lorries

Trip information

Viewing trip data from the map
Before you can view trip data on the map, you must add the tool to the map tools menu.

From the map, select  > Trip Data.

Viewing Customised Trip Information on the Map
You can use the trip data map tool to show customised trip information on the map.
1 From the map, select  > Trip Data.
2 Select an option:

• Select a data field in the trip data tool  and select the information to show in the field.
• Select the customisable map data field , and select the information to show in the field.

Viewing the trip information page
The trip information page displays your speed and provides statistics about your trip.

From the map, select Speed.
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Resetting trip information
1 From the map, select Speed.
2 Select  > Reset Field(s).
3 Select an option:

• When not navigating a route, select Select All to reset every data field except the speedometer, on the first 
page.

• Select Reset Overall Data to reset Trip A and total data.
• Select Reset Trip B to reset the odometer.
• Select Reset Max. Speed to reset the maximum speed.

Viewing upcoming traffic
NOTICE

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Before you can use this feature, your device must be receiving traffic data (Traffic, page 39).
You can view traffic incidents coming up along your route or along the road on which you are travelling.
1 While navigating a route, select  > Traffic.

The nearest upcoming traffic incident appears in a panel on the right side of the map.
2 Select the traffic incident to view additional details.

Viewing traffic on the map
The traffic map shows colour-coded traffic flow and delays on nearby roads.
1 From the main menu, select  > Traffic.
2 If necessary, select  > Legend to view the legend for the traffic map.

Searching for traffic incidents
1 From the main menu, select  > Traffic.
2 Select  > Incidents.
3 Select an item in the list.
4 If there is more than one incident, use the arrows to view additional incidents.

Customising the map

Customising the map layers
You can customise which data appears on the map, such as topographic maps and BirdsEye imagery.
1 Select  > Map & Vehicle > Map Layers.
2 Select the tick box next to each layer you want to show on the map.

Changing the map data field
1 From the map, select a data field.

NOTE: you cannot customise Speed.
2 Select a type of data to display.
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Changing the map perspective
1 Select  > Map & Vehicle > Driving Map View.
2 Select an option:

• Select Track Up to display the map in two dimensions (2-D), with your direction of travel at the top.
• Select North Up to display the map in 2-D with North at the top.
• Select 3-D to display the map in three dimensions.

Live services, traffic and smartphone features
 WARNING

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead 
to an accident resulting in serious personal injury or death.

The dēzl app allows your device to receive smart notifications and live information, such as live traffic data and 
weather information.
Live traffic data: sends real-time traffic data to your device, such as traffic incidents and delays, construction 

zones and road closings (Traffic, page 39).
Weather information: sends real-time weather forecasts, road conditions and weather radar to your device 

(Viewing the Weather Forecast, page 44).
Hands-Free calling: allows you to make and receive phone calls using your device, and allows you to use the 

device as a hands-free speaker phone.
Send locations to device: allows you to send locations from your smartphone to your navigation device.

Pairing with Your Smartphone
You can pair your dēzlCam device with your smartphone and the dēzl app to enable additional features and 
access live information (Live services, traffic and smartphone features, page 34) .
1 From the app store on your smartphone, install the dēzl app.
2 Turn on your dēzlCam device and place the device and your smartphone within 3 m (10 ft.) of each other.
3 On your phone, open the dēzl app.
4 Follow the on-screen instructions to sign in to a Garmin account and complete the pairing and setup 

process.
The main app dashboard appears. After the devices are paired, they connect automatically when they are turned 
on and within range.

Disabling Bluetooth features (Android™)
By default, all compatible Bluetooth features are enabled when you pair your phone. You can disable specific 
Bluetooth features and remain connected to the other features.
1 Select  > Wireless Networks.
2 Select an option:

• To disable all Bluetooth features, clear the Bluetooth tick box.
• To disable only hands-free calling, select the phone name and clear the Phone calls tick box.

Showing or hiding app notifications (Android)
You can use the dēzl app to customise which types of smartphone notifications appear on your dēzlCam 
device.
1 On your phone, open the dēzl app.
2 Select  > Smart Notifications.

A list of your smartphone apps appears.
3 Select the toggle switch next to an app to enable or disable notifications for the app.
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Disabling Bluetooth features (iPhone®)
By default, all compatible Bluetooth features are enabled when you pair your phone. You can disable specific 
Bluetooth features and remain connected to the other features.
1 Select  > Wireless Networks.
2 Select an option:

• To disable hands-free calling, select the phone name and clear the Phone calls check box.
TIP:  appears coloured next to the phone name used for hands-free calling.

• To disable dēzl app data and smartphone notifications, select Smartphone services and clear the 
Smartphone services check box.
TIP:  and  appear coloured when the services are active.

Showing or hiding notification categories (iPhone)
You can filter the notifications shown on your device by showing or hiding categories.
1 Select  > Wireless Networks.
2 Select Smartphone services.

TIP:  and  appear coloured when the services are active.
3 Select Smart Notifications.
4 Select the check box next to each notification to show.

Viewing Videos and Photos on Your Smartphone
Before you can view videos and photos on your smartphone, you must pair your dēzlCam device with the dēzl 
app (Pairing with Your Smartphone, page 34).
NOTE: the device stops recording and alerts are disabled while viewing videos or photos.
1 From the dēzl app on your smartphone, select Videos and photos.
2 Select an option:

• To view a photo or video you saved, select a file from the Favourites category.
• To view recent video footage that has not been saved, select a video from the Temporary category.

Deleting a Video or Photo Using Your Smartphone
1 When you are viewing the list of saved videos or photos on your smartphone, select Select.
2 Select one or more files.
3 Select .

Bluetooth Feature status icons
Status icons appear in the Bluetooth settings next to each paired device.
Select  > Wireless Networks.
• A grey icon indicates the feature is disabled or disconnected for that device.
• A coloured icon indicates the feature is connected and active for that device.

Hands-free calling

dēzl features and services
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Smart Notifications
While your device is connected to the dēzl app, you can view notifications from your smartphone on your 
dēzlCam device, such as text messages, incoming calls, and calendar appointments.
NOTE: you may need to wait a few minutes to receive notifications on your navigation device after it connects to 
the dēzl app.  appears coloured in the Bluetooth settings when smart notifications are connected and active 
(Bluetooth Feature status icons, page 35).

Receiving notifications
 WARNING

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead 
to an accident resulting in serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the dēzl app (Live 
services, traffic and smartphone features, page 34).
From most pages, a pop-up appears when the device receives a notification from your smartphone. If the device 
is moving, you must verify you are a passenger and not the driver before you can view notifications.
NOTE: if you are viewing the map, notifications appear in a map tool.
• To ignore a notification, select OK.

The pop-up closes, but the notification remains active on your phone.
• To view a notification, select View.
• To listen to the notification, select View > Play.

The device reads the notification using text-to-speech technology. This feature is not available for all 
languages.

• To perform additional actions, such as dismissing the notification from your phone, select View, and select 
an option.
NOTE: additional actions are available for only some notification types and must be supported by the app 
generating the notification.

Receiving notifications while viewing the map

 WARNING
Do not read or interact with notifications while driving, because doing so can cause distraction that could lead 
to an accident resulting in serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the dēzl app (Live 
services, traffic and smartphone features, page 34).
When you are viewing the map, new notifications appear in a map tool at the edge of the screen. If the device is 
moving, you must verify you are a passenger and not the driver before you can view notifications.
• To ignore a notification, select  or wait for the pop-up to expire.

The pop-up closes, but the notification remains active on your phone.
• To view a notification, select the notification text.
• To listen to the notification, select Play Message.

The device reads the notification using text-to-speech technology. This feature is not available for all 
languages.
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Viewing the list of notifications
You can view a list of all active notifications.
1 Select  > Smart Notifications.

The list of notifications appears. Unread notifications appear black, and previously read notifications appear 
grey.

2 Select an option:
• To view a notification, select the notification description.
• To listen to a notification, select .

The device reads the notification using text-to-speech technology. This feature is not available for all 
languages.

Going to an address or location using the dēzl app
You can use the dēzl app to search for an address, business or point of interest and send it to your dēzlCam 
device for navigation.
1 From the dēzl app, select Where To?.
2 Select an option:

• To search for an address near you, enter the house number and street name.
• To search for an address in another town, enter the house number, street name, town and county.
• To search for a business name, enter all or part of the name.
• To search for a town, enter the town and county.
As you type, suggestions appear below the search field.

3 Select a suggested search result.
The app displays the location on a map.

4 Select Go! to start a route.
The dēzlCam device starts navigating to the selected location and the location is added to your recent searches 
in the Where To? menu.

Hands-free calling
NOTE: while most phones are supported and can be used, it cannot be guaranteed that a particular phone can 
be used. All features may not be available for your phone.
Using Bluetooth wireless technology, your device can connect to your mobile phone to become a hands-free 
device (Live services, traffic and smartphone features, page 34). While connected, you can place or receive calls 
using your device.

Placing a call
Dialling a number
1 Select  > Phone > Dial.
2 Enter the number.
3 Select Dial.

Calling a contact in your phone book
Your phone book is loaded from your phone to the device each time your phone and the device connect. It may 
take a few minutes for the phone book to be available. Some phones do not support this feature.
1 Select  > Phone > Phone Book.
2 Select a contact.
3 Select Call.

Live services, traffic and smartphone features 37



Calling a location
1 Select  > Phone > Browse Categories.
2 Select a point of interest.
3 Select  > Call.

Placing a Call Using Voice Dial
1 Select  > Phone > Voice Dial.
2 Listen for the voice prompt.
3 Say Call and say the contact name, phone number or location you want to call.

Receiving a call
When you receive a call, select Answer or Ignore.

Using the call history
Your call history is loaded from your phone to the device each time your phone and the device connect. It may 
take a few minutes for the call history to be available. Some phones do not support this feature.
1 Select  > Phone > Call History.
2 Select a category.

A list of calls appears, with the most recent calls at the top.
3 Select a call.

Using in-call options
In-call options appear on the map when you answer a call. Some options may not be compatible with your 
phone.
TIP: if you close the in-call options page, you can open it again by selecting  from the main menu. You can also 
select  > Phone from the map.
• To set up a conference call, select the caller ID and select Add Call.
• To transfer audio to your phone, select Handset.

TIP: you can use this feature if you want to disconnect the Bluetooth connection and remain on the call, or if 
you need privacy.

• To use the dial pad, select the caller ID and select Keypad.
TIP: you can use this feature to use automated systems, such as voice mail.

• To mute the microphone, select Mute.
• To hang up, select End.

Saving a home phone number
TIP: after you save a home number, you can edit the home number by editing "Home" in your list of favourite 
locations (Editing a Saved Location, page 21).
1 Select  > Phone >  > Set Home Number.
2 Enter your phone number.
3 Select Done.

Calling home
Before you can call home, you must enter a phone number for your home location.

Select  > Phone > Call Home.

38 Live services, traffic and smartphone features



Deleting a paired phone
You can delete a paired phone to prevent it from automatically connecting to your device in the future.
1 Select  > Wireless Networks.
2 Select the phone, then select Forget Device.

Traffic
NOTICE

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Your device can provide information about traffic on the road ahead or on your route. You can set your device to 
avoid traffic when calculating routes, and to find a new route to your destination if a large traffic delay occurs on 
your active route (Traffic Settings, page 58). The traffic map allows you to browse the map for traffic delays in 
your area.
To provide traffic information, your device must be receiving traffic data.
• All product models can receive subscription-free traffic data using the dēzl app (Receiving traffic data using 

your smartphone, page 39).
Traffic data is not available in all areas. For information about traffic coverage areas, go to garmin.com/traffic.

Receiving traffic data using your smartphone
Your device can receive subscription-free traffic data while connected to a smartphone running the dēzl app.
1 Connect your device to the dēzl app (Live services, traffic and smartphone features, page 34).
2 On your dēzlCam device, select  > Traffic and verify that the Traffic option is selected.

Enabling traffic
You can enable or disable traffic data.
1 Select  > Traffic.
2 Select the Traffic tick box.

Viewing traffic on the map
The traffic map shows colour-coded traffic flow and delays on nearby roads.
1 From the main menu, select  > Traffic.
2 If necessary, select  > Legend to view the legend for the traffic map.

Searching for traffic incidents
1 From the main menu, select  > Traffic.
2 Select  > Incidents.
3 Select an item in the list.
4 If there is more than one incident, use the arrows to view additional incidents.

Traffic 39

http://garmin.com/traffic


Vehicle and driver tools
Break Planning

NOTICE
This device by itself is NOT an approved substitute for logbook recording requirements under US Federal Motor 
Carrier Safety Administration (FMCSA) regulations. Drivers should comply with all applicable hours-of-service 
requirements. When integrated with a Garmin eLog compliant Electronic Logging Device (ELD), the Garmin 
eLog device enables a motor carrier to comply with hours of service logging and break requirements. For more 
information, or to purchase a Garmin eLog device, go to garmin.com/elog.

When the break planning feature is enabled, the device notifies you one hour before suggested break times and 
drive hour limits and suggests break locations on your route. You can use this feature to keep track of your 
working hours, which may help you comply with safety regulations.
NOTE: break planning features are not available when using the car vehicle profile.

Taking a suggested break
When it is time for a break, the device notifies you and displays suggested break location POIs along your route.

Select a POI from the list of suggested break locations.
The device adds the break location as the next destination on your route.

Starting the break timer
The break timer starts automatically when the vehicle is moving at least 5 mph (8 kph) for 30 seconds. You can 
start the timer manually at any time.
1 From the map, select  > Break Planner.
2 Select Start Timer.

Pausing and resetting the break timer
The break timer pauses automatically when the vehicle stops for three minutes or longer. You can pause the 
timer manually for brief stops, such as parking or stopping at motorway services. At the end of your drive, you 
can manually reset the timer.
1 Select Stop Timer.
2 Select an option:

• To pause the timer, select Pause.
• To stop and reset the timer, select Reset.

Adjusting drive hours
You can adjust your total hours driven to more closely match your hours of service records.
1 While using the break planner feature, select Total Hours Driven.
2 Enter the total hours driven.
3 Select Save.

Adjusting the daily driving limit
You can adjust the daily driving limit to correspond with legal requirements in your area.
NOTE: this feature is not available in all areas.
1 While using the break planner feature, select Daily Hours Driven.
2 Select the daily driving limit for your area.
3 Select Save.
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Garmin eLog
The Garmin eLog adapter enables a motor carrier to comply with hours of service logging and break 
requirements. When a Garmin eLog adapter is paired with your compatible mobile device, you can view hours 
of service information on your dēzlCam device. The Garmin eLog adapter is not available in all areas. For more 
information, or to purchase a Garmin eLog adapter, go to garmin.com/elog.
NOTE: Garmin eLog features are not available when using the car vehicle profile.

Setting Up Garmin eLog Features On Your dēzl Device
1 Pair your Garmin eLog adapter with the Garmin eLog app on your mobile device (Setting Up Your Garmin 

eLog Device, page 41).
2 Pair your dēzl device with your compatible mobile device (Live services, traffic and smartphone features, 

page 34).
3 Enable the Garmin eLog app to pair with a dēzl device (Enabling the Garmin eLog App to Pair with a dēzl 

Device, page 41).
4 If necessary, enable the Garmin eLog connection on your dēzl device (Enabling or Disabling the Garmin eLog 

Connection on Your dēzl Device, page 41).

Setting Up Your Garmin eLog Device
You must set up and pair your Garmin eLog adapter with the Garmin eLog app in order to use the device.
1 From the app store on your mobile device, install and open the  Garmin eLog app.
2 On your mobile device, follow the on-screen instructions to set up and configure the Garmin eLog system.

NOTE: until you complete the setup process, the device has limited functionality.

Enabling the Garmin eLog App to Pair with a dēzl Device
1 From the Garmin eLog app, log in to a driver profile.
2 Select Settings > Pair to Nearby Garmin dēzl.

Enabling or Disabling the Garmin eLog Connection on Your dēzl Device
1 From your dēzl device, select  > Wireless Networks.
2 Select the name of your paired mobile device.
3 Select or clear the Garmin eLog Adapter check box.

Viewing Garmin eLog Information on Your dēzl Device
Before you can view Garmin eLog information on your dēzl device, you must complete the setup process 
(Setting Up Your Garmin eLog Device, page 41).
As you drive your vehicle, the device displays your duty status and total drive hours in the Garmin eLog map 
tool.

Select a field to view a summary of remaining drive hours.

Viewing Garmin eLog Diagnostic and Malfunction Events
When the Garmin eLog device detects a diagnostic or malfunction event, it displays a notification on the device 
screen.

Select the diagnostic or malfunction notification to view details about the event.
NOTE: you can view additional information about diagnostic and malfunction events in the Garmin eLog app.

IFTA
NOTE: this feature is not available in all areas.
Before you can use this feature, a lorry vehicle profile must be active.
You can record data needed for International Fuel Tax Agreement documentation (IFTA), such as fuel-purchase 
data and miles driven.
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Entering fuel data
1 Select  > IFTA > At the Pump.
2 Enter the fuel price per gallon.
3 Select the Fuel Used field.
4 Enter the amount of fuel purchased.
5 If necessary, select the fuel type:

• To record the amount in litres, select Gallons > Litres > Save.
• To record the amount in gallons, select Litres > Gallons > Save.

6 If necessary, select the Tax Included tick box.
7 Select Next.
8 Select an option to record the fuel station where you refuelled:

• Select a nearby fuel station from the list.
• Select the text field, and enter the fuel station name and address.

9 Select the fuel purchaser.

Editing fuel data
1 Select  > IFTA > Fuel Journals.
2 If necessary, select a vehicle profile.
3 If necessary, select a quarter.
4 Select a fuel record.
5 Select an option:

• Select a field to edit the information.
• Select  to delete the record.

Viewing and Exporting a Jurisdiction Summary
The jurisdiction summary lists data for every area in which your vehicle has operated during each quarter. The 
jurisdiction summary is available in some areas.
1 Select  > IFTA > Jurisdiction Summary.
2 If necessary, select a lorry.
3 If necessary, select a quarter.
4 Select  > Export > OK to export a jurisdiction summary.

The device exports the summary to a .csv file and stores it in the Reports folder on the device.

Editing and exporting trip reports
1 From the main menu, select  > IFTA > Trip Reports.
2 If necessary, select a lorry.
3 If necessary, select a quarter.
4 Select a report.
5 Select an option:

• Select  > Delete, and select the tick box to delete a report.
• Select  > Combine, and select the tick boxes to combine reports.
• Select  > Export > OK. The device exports the report to a .csv file and stores it in the Reports folder on 

the device.
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Viewing Exported Jurisdiction Summaries and Trip Reports
NOTICE

If you do not know the purpose of a file, do not delete it. Your device memory contains important system files 
that should not be deleted.

1 Connect the device to your computer.
2 From the file browser on your computer, browse to the internal device storage and open the Reports folder.
3 Open the IFTA folder.
4 Open the .csv file.

Logging service history
You can log the date and odometer reading when service or maintenance is performed on your vehicle. The 
device provides several service categories, and you can add custom categories (Adding service categories, 
page 43).
1 Select  > Service History.
2 Select a service category.
3 Select Add Record.
4 Enter the odometer reading, and select Next.
5 Enter a comment (optional).
6 Select Done.

Adding service categories
1 Select  > Service History.
2 Select  > Add Category.
3 Enter a category name, and select Done.

Deleting service categories
When you delete a service category, all service records in the category are also deleted.
1 Select  > Service History.
2 Select  > Delete Categories.
3 Select the service categories to delete.
4 Select Delete.

Renaming service categories
1 Select  > Service History.
2 Select the category to be renamed.
3 Select  > Rename Category.
4 Enter a name and select Done.

Deleting service records
1 Select  > Service History.
2 Select a service category.
3 Select  > Delete Records.
4 Select the service records to be deleted.
5 Select Delete.
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Editing a service record
You can edit the comment, odometer reading and date of a service record.
1 Select  > Service History.
2 Select a category.
3 Select a field.
4 Enter the new information, and select Done.

PrePass®

NOTICE
Garmin is not responsible for the accuracy or timeliness of the information provided by the PrePass app.

NOTE: Before you can use this feature, you must have an active PrePass account.
The PrePass app enables drivers to verify the safety, credentials, and weight of a commercial vehicle with 
upcoming weigh stations. You can pair your dēzlCam device with the dēzl app and the PrePass app to receive 
upcoming weigh station notifications on your dēzlCam device.
NOTE: This feature is available only in the United States.

Loyalty Programmes
From your dēzlCam device, you can access loyalty programmes from some of the travel plazas in the United 
States, including Love's Travel Stops and Pilot Flying J Travel Centers. You can use the loyalty programme apps 
on your dēzlCam device to check reward points balances and other loyalty programme information. To activate 
loyalty programme features, sign in to your loyalty programme account in the dēzl app.
NOTE: this feature is available only in the United States.

Using the apps
Viewing the Owner's Manual on Your Device
You can view the complete owner's manual on the device screen in many languages.
1 Select  > Owner's Manual.

The owner's manual appears in the same language as the software text (Language and Keyboard Settings, 
page 59).

2 Select  to search the owner's manual (optional).

Viewing the Weather Forecast
NOTICE

Garmin is not responsible for the accuracy or timeliness of the weather data.

Before you can use this feature, your device must be receiving weather data. You can connect your device to the 
dēzl app to receive weather data (Live services, traffic and smartphone features, page 34). 

1 Select  > Weather.
The device shows the current weather conditions and a forecast for the next several days.

2 Select a day.
The detailed forecast for that day appears.

Viewing weather near a different town
1 Select  > Weather > Current Location.
2 Select an option:

• To view weather for a favourite town, select a town in the list.
• To add a favourite town, select Add Town, and enter a town name.
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Viewing the weather radar
Before you can use this feature, your device must be connected to a supported phone running the dēzl app (Live 
services, traffic and smartphone features, page 34).
1 Select  > Weather Radar.
2 Select  to animate the radar map.

Viewing weather alerts
Before you can use this feature, your device must be connected to a supported phone running the dēzl app (Live 
services, traffic and smartphone features, page 34).
NOTE: this feature is not available in all areas.
While you are travelling with your device, weather alerts may appear on the map. You can also view a map of 
weather alerts near your current location or near a selected town.
1 Select  > Weather.
2 If necessary, select a town.
3 Select  > Weather Alerts.

Checking road conditions
Before you can use this feature, your device must be connected to a supported phone running the dēzl app (Live 
services, traffic and smartphone features, page 34).
You can view weather-related road conditions for the roads in your area, on your route or in another town.
1 Select  > Weather.
2 If necessary, select a town.
3 Select  > Road Conditions.

Route Planner
You can use the route planner to create and save a route, which you can navigate later. This can be useful for 
planning a delivery route, a vacation, or a road trip. You can edit a saved route to further customise it, including 
reordering locations, adding suggested attractions and adding shaping points.
You can also use the route planner to edit and save your active route.

Planning a Route
A route can include many locations and it must include at least a starting location and one destination. The 
starting location is the location from which you plan to start your route. If you start navigating the route from 
a different location, the device gives you the option to route to your starting location first. For a round trip, the 
starting location and final destination can be the same.
1 Select  > Route Planner > Create Route.
2 Select Select Start Location.
3 Choose a location for your starting point, and select Select.
4 Select Select Destination.
5 Choose a location for a destination, and select Select.
6 Select Add Location to add more locations (optional).
7 After you have added all the necessary locations, select Next > .
8 Enter a name and select Done.
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Editing and Reordering Locations in a Route
1 Select Route Planner.
2 Select a saved route.
3 Select List.
4 Select a location.
5 Select an option:

• To change the location, select , and enter a new location.
• To move the location up or down, select  and drag the location to a new position in the route.
• To add a new location after the selected location, select .
• To remove the location, select .

Changing Routing Options for a Route
You can customise how the device calculates your route.
1 Select  > Route Planner.
2 Select a saved route.
3 Select .
4 Select an option:

• To add shaping points to your route, select Shaping and select at least one location.
• To change the calculation mode for the route, touch a route segment and select a calculation mode.

Navigating to a Saved Route
1 Select  > Route Planner.
2 Select a saved route.
3 Select Go!.
4 Select the first location to navigate to and select OK.
5 Select Start.

The device calculates a route from your current location to the selected location and then it guides you to the 
remaining route destinations in order.

Editing and saving your active route
If a route is active, you can use the route planner to edit and save it.
1 Select  > Route Planner > My Active Route.
2 Edit your route using any of the route planner features.

The route recalculates each time you make a change.
3 Select Save to save your route, which you can navigate again later (optional).

photoLive traffic cameras
Before you can use this feature, your device must be connected to the dēzl app (Live services, traffic and 
smartphone features, page 34).
photoLive traffic cameras provide live images of traffic conditions on major roads and junctions.
The photoLive service is not available in all areas.
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Viewing and Saving photoLive Traffic Cameras
You can view live images from nearby traffic cameras. You can also save traffic cameras for areas you travel 
frequently.
1 Select  > photoLive.
2 Select Touch to Add
3 Select a road.
4 Select a traffic camera location.

A preview of the live image from the camera appears next to a map of the camera's location. You can select 
the image preview to view the full-sized image.

5 Select Save to save the camera (optional).
A thumbnail image preview of the camera is added to the main screen of the photoLive app.

Viewing photoLive Traffic Cameras on the Map
The photoLive map tool shows traffic cameras from the road ahead of you.
1 From the map, select  > photoLive.

The device shows the live image from the nearest traffic camera on the road ahead, along with the distance 
to the camera. When you pass the camera, the device loads the live image of the next camera on the road.

2 If no cameras are found for the road, select Find Cameras to view or save nearby traffic cameras (optional).

Saving a traffic camera
1 Select  > photoLive.
2 Select Touch to Add.
3 Select a traffic camera.
4 Select Save.

Wireless Cameras
Your device can display the video feed from one or more connected wireless cameras (sold separately).

Pairing the BC 40 Camera with a Garmin Navigation Device
You can pair the camera with a compatible Garmin navigation device. For more information about compatible 
Garmin devices, go to the product page at garmin.com/bc40.
1 Update your navigation device to the latest software.
2 Install batteries in the camera.

The camera enters pairing mode automatically and the LED flashes blue while the camera is in pairing mode. 
The camera remains in pairing mode for two minutes. If pairing mode expires, you can remove and reinstall 
the batteries.

3 Bring the compatible Garmin navigation device outside your vehicle and within 1.5 m (5 ft.) of the camera 
and turn on the navigation device.
The device detects your camera automatically and prompts you to pair with it.

4 Select Yes.
TIP: if the navigation device does not detect the camera automatically, you can select  > Wireless Camera 
> Add New Camera to pair with it manually. The location of the pairing menu may vary by device model. See 
the owner's manual for your navigation device for additional pairing instructions.
The device pairs with your camera.

5 Enter a name for the camera (optional).
You should use a descriptive name that clearly identifies the location of the camera.

6 Select Done.
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Pairing a BC 50 Camera with a Garmin Navigation Device
You can pair the BC 50 camera with a compatible Garmin navigation device. Go to garmin.com/bc50 for more 
information about device compatibility.
1 Update your navigation device to the latest software.

Your device may not support the BC 50 camera without the latest software. For more information about 
updating the device software, see the owner's manual for your navigation device.

2 Select  > Wireless Camera > Add New Camera.
3 Follow the on-screen instructions to finish pairing and setting up the camera.
After you complete the pairing process with a camera for the first time, it connects automatically to the Garmin 
navigation device when power is applied.

Viewing the Backup Camera
 WARNING

This device is intended to enhance your situational awareness when used properly. If used improperly, you 
could become distracted by the display, which could lead to an accident causing serious personal injury or 
death. Only access the information displayed on the device with a glance. Always maintain awareness of your 
surroundings and do not stare at the display or become distracted by the display. Focussing on the display 
could prevent you from avoiding obstacles or hazards.

• If your camera is connected to a reverse lamp (recommended), place the vehicle into reverse.
• If your camera is connected to constant power, select .
• To show or hide the camera view using voice commands, say OK Garmin, Show Video or Hide Video.

NOTE: voice commands are not available on all navigation devices. The voice commands may vary based 
on your navigation device model. This feature is not available for all languages or may require additional 
navigation device setup for some languages.
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Aligning the Guidance Lines
For the best reference, the guidance lines should be aligned to reflect the outside edges of the vehicle. You 
should align the guidance lines separately for each backup camera. When you change the camera angle, you 
should immediately align the guidance lines again.
1 Position your vehicle with the driver's side closely aligned to a kerb, driveway or parking stall lines.

TIP: it can be helpful to position the vehicle in the centre of a parking stall and then pull forward into the next 
stall. This allows you to use the parking stall lines at the rear of the vehicle as reference points for alignment.

2 From the paired Garmin navigation device, select  > Wireless Cameras.
3 Select the paired camera name and select Guidance Lines > Adjust Guidance Lines.
4 Use the arrows in the corners of the screen to move the ends of the white, driver's-side guidance line.

The guidance line should appear directly on top of the kerb, driveway or parking stall line.

5 Use the arrows in the centre of the screen to move the coloured distance guidance lines up or down.
The red guidance line should be aligned with the rearmost part of your vehicle. This could be the rear 
bumper, a trailer hitch or another object protruding from the rear of the vehicle.

6 Reposition the vehicle with the passenger side closely aligned to a kerb, driveway or parking stall lines and 
use the arrows to align the white, passenger-side guidance line.
The guidance lines should be symmetrical.

Viewing Previous Routes and Destinations
Before you can use this feature, you must enable the travel history feature (Device and privacy settings, 
page 59).
You can view your previous routes and places where you have stopped on the map.

Select  > Trip History.
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Music Player
The music player allows your device to control the music currently playing from a media app on your paired 
phone. You can open the media player at any time by selecting Music from the main menu.

Information about the currently playing media, such as title, artist, album, station or channel.

Progress through the current media item.

Playback controls. The controls change based on the source providing the media.

Volume controls. You can use the slider to adjust the volume.

The name of the connected media source.

Adding the Music Player Tool to the Map
The music player map tool enables you to control the music player from your map.
1 Open the map.
2 Select  > Music.

The music player controls appear on the map.
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Garmin PowerSwitch™ App

 Opens the app settings menu

 Enters editing mode to customise the app layout and functions

 Turns off all outputs

 Power buttons Activates each connected output

Displays input voltage

Displays the total amperage of the selected Garmin PowerSwitch device

Displays the device name

Displays Garmin PowerSwitch device tabs and custom layout tabs

Activating a Power Switch
Before you can use the Garmin PowerSwitch app to activate a switch, you must install your Garmin 
PowerSwitch device in your vehicle and pair it with the Garmin PowerSwitch app.

From the Garmin PowerSwitch app, select a power button to turn a switch on or off.

Turning Off All Switches
Select .
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Customising a Button
1 From the Garmin PowerSwitch app screen, select .

The app enters editing mode.
2 Select  on the button you want to customise.
3 Select an option:

• To change the name of the button, select the Button Label field and enter a name.
• To add an icon to the button, select the Icon field and select an icon.
• To change the button colour, select a colour.
• To change the button mode, select a button mode.
• To adjust the intensity of the switch, use the slider.
• To set the button to activate with a control input, select a control input.

4 Select .
5 Select Done.

Assigning a Switch to a Control Input
Before you can use control input functions, you must connect a control input to your Garmin PowerSwitch 
device.
You can assign one or more switches to turn on when the Garmin PowerSwitch device receives a signal from a 
control input.
1 Select .
2 Select your Garmin PowerSwitch device.
3 Select a control input.
4 Select one or more switches.

Adding a Custom Layout
You can add a custom layout tab to the Garmin PowerSwitch app. Buttons added to a custom layout can control 
multiple switches at the same time.
1 From the Garmin PowerSwitch app, select .

The device enters editing mode.
2 Select .
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Adding a Button to a Custom Layout
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .

The app enters editing mode.
3 Select Add Button.
4 On the new button, select .
5 Select an option:

• To change the name of the button, select the Button Label field and enter a name.
• To add an icon to the button, select the Icon field and select an icon.
• To change the button colour, select a colour.

6 Select Add Action.
7 If necessary, select a Garmin PowerSwitch device and a switch.
8 Select an action:

• To set the button to turn the switch on or off with each press, select Toggle.
• To set the button to turn on the switch, select Turn On.
• To set the button to turn off the switch, select Turn Off.

9 Select a button mode:
• To set the button to activate with one touch, select Normal.
• To set the button to activate only while touching the button, select Momentary.
• To set the button to turn on and off repeatedly, select Strobe and select time intervals.

10 If applicable, use the slider to set the brightness of lights.
11 Select .
12 If necessary, select Add Action to add additional actions to the button.

You can add one action for every switch on the Garmin PowerSwitch device.

Arranging Buttons In a Custom Layout
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .

The app enters editing mode.
3 On the button that you want to move, hold , and drag the button to a new location.

Deleting a Custom Layout or Button
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .

The app enters editing mode.
3 Select an option:

• To delete a button, select  on the button you want to delete.
• To delete a layout tab, select  on the layout tab.

Routines
Routines automate your Garmin PowerSwitch device. When you define a routine on your compatible Garmin 
navigation device, it turns switches on or off automatically when the conditions of the routine are met. For 
example, you can set a routine to turn on a switch at specific time each day or when your vehicle reaches a 
specific speed. Routines are available only when using a compatible Garmin navigation device.
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Adding a Routine
1 From the Garmin PowerSwitch app, select  > Routines.
2 If necessary, select Add Routine.
3 Select When.
4 Select a trigger:

• To set a switch to trigger when your vehicle reaches a specific speed, select Speed > Next and follow the 
on-screen instructions to enter speed thresholds.

• To set a switch to trigger at a specific time each day, select Time > Next and enter a time.
• To set a switch to trigger at sunrise, select Sunrise.
• To set a switch to trigger at sunset, select Sunset.

5 Select Add Action.
6 Select a device, a switch, an action and a button mode.
7 If necessary, use the slider to adjust the dimmer.
8 Select Save.

Editing a Routine
1 From the Garmin PowerSwitch app, select  > Routines.
2 Select on the routine you want to edit.
3 Select an option:

• To change the trigger for the routine, select When and select a trigger.
• To change an action, select on the action you want to change and update the action.
• To add an action to the routine, select Add Action and enter information about the action.

4 Select Save.

Deleting a Routine
1 From the Garmin PowerSwitch app, select  > Routines.
2 Select on the routine you want to delete.

Voice Command
NOTE: voice command is not available for all languages and regions, and may not be available on all models.
NOTE: Voice Activated Navigation may not achieve desired performance when in a noisy environment.
Voice command allows you to use your device by saying words and commands. The voice command menu 
provides voice prompts and a list of available commands.

Tips for Speaking to the Device
• Speak in a clear voice directed at the device.
• Start each request with OK, Garmin.
• Reduce background noise, such as voices or the radio, to help the device interpret your commands more 

accurately.
• Respond to voice prompts from the device as needed.
• If you do not receive a useful response, try rephrasing your request.
• If the device does not respond to your requests, verify that it is not placed near a speaker or air vent, which 

can produce noise that interferes with the microphone.
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Launching Garmin Voice-Activated Navigation
Garmin voice-activated navigation allows you to use requests spoken in plain language to search for locations 
and addresses, start routes with turn-by-turn directions, place hands-free phone calls and more.
• Say OK, Garmin, and make a spoken request.

For example, you can say phrases like these:
◦ OK, Garmin, take me home.
◦ OK, Garmin, where's the library?

Controlling the Camera Using Voice Commands
1 Say OK Garmin to activate the voice control feature.

The camera plays a tone and starts listening for a command.
2 Say a command:

• To save a video, say Save Video.
• To take a picture, say Take a Picture.
The camera plays a tone when it recognises your command.

Checking Your Arrival Time
While a route is active, you can say a phrase to check your estimated time of arrival at your destination.

Say OK, Garmin, what time will we arrive?.

Placing a Phone Call Using Your Voice
You can use a voice command to call a contact from the phone book of your paired smartphone.

Say OK, Garmin, call, and say the contact name.
For example, you can say OK, Garmin, call Mum..

Changing Device Settings Using Your Voice
You can say phrases like these to set device settings to a value from 0 to 10.
• OK, Garmin, increase the volume.
• OK, Garmin, set the volume to 0.
• OK, Garmin, set the volume to 9.
• OK, Garmin, decrease the brightness.
• OK, Garmin, set the brightness to 5.

Settings
Map and vehicle settings
Select  > Map & Vehicle.
Vehicle: sets the vehicle icon that represents your position on the map.
Driving Map View: sets the perspective on the map.
Map Detail: sets the level of detail on the map. More detail may cause the map to be drawn more slowly.
Map Theme: changes the colour of the map data.
Map Layers: sets the data that appears on the map page (Customising the map layers, page 33).
Auto Zoom: automatically selects the zoom level for optimal use of your map. When disabled, you must zoom in 

or out manually.
Skip Next Stop Confirmation: sets a confirmation message to appear when skipping a location on your route.
myMaps: sets which installed maps the device uses.
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Enabling maps
You can enable map products installed on your device.
TIP: to purchase additional map products, go to http://buy.garmin.com.
1 Select  > Map & Vehicle > myMaps.
2 Select a map.

Navigation settings
Select  > Navigation.
Calculation Mode: sets the route calculation method.
Avoidances: sets road features to avoid on a route.
Custom Avoidances: allows you to avoid specific roads or areas.
Environmental Zones: sets the avoidance preferences for areas with environmental or emissions restrictions 

that may apply to your vehicle.
Restricted Mode: disables all functions that require significant operator attention.
GPS Simulator: stops the device from receiving a GPS signal and saves battery power.

Calculation Mode Settings
Select  > Navigation > Calculation Mode.
The route calculation is based on road speeds and vehicle acceleration data for a given route.
Faster Time: calculates routes that are faster to drive but can be longer in distance.
Off Road: calculates a direct line from your location to your destination.

Setting a simulated location
If you are indoors or not receiving satellite signals, you can use the GPS simulator to plan routes from a 
simulated location.
1 Select  > Navigation > GPS Simulator.
2 From the main menu, select View Map.
3 Tap the map twice to select an area.

The address of the location appears at the bottom of the screen.
4 Select the location description.
5 Select Set Location.
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Wireless network settings
The wireless network settings allow you to manage Wi‑Fi networks, paired Bluetooth devices and Bluetooth 
features.
Select  > Wireless Networks.
Bluetooth: enables Bluetooth wireless technology.
Paired Device Name: the names of paired Bluetooth devices appear in the menu. You can select a device name 

to change Bluetooth feature settings for that device.
Search for Devices: searches for nearby Bluetooth devices.
Friendly Name: allows you to enter a friendly name that identifies your device on other devices with Bluetooth 

wireless technology.
Wi-Fi: enables the Wi‑Fi technology.
Saved Networks: allows you to edit or remove saved networks.
Search for Networks: searches for nearby Wi‑Fi networks (Connecting to a Wi‑Fi Network, page 60).

Driver Assistance Settings
Select  > Driver Assistance.
Driver Alerts: allows you to enable or disable alerts for upcoming zones or road conditions (Driver awareness 

features and alerts, page 11).
Speeding Alert: alerts you when you are exceeding the speed limit.
Reduced Speed Tone: alerts you when the speed limit decreases.
Route Preview: displays a preview of the major roads on your route when you start navigation.
Break Planning: reminds you to take a break, and displays upcoming services after you drive for an extended 

time. You can enable or disable break reminders and upcoming service suggestions.
Proximity Alerts: alerts you when you approach speed cameras or red light cameras.
Plan Arrival: displays a map of your destination at the end of a route. You can also enable your device to 

download satellite imagery using the mobile data on your paired smartphone.
Forward collision warning: allows you to enable and set the sensitivity of the forward collision warning. A higher 

sensitivity alerts you sooner than a lower sensitivity.
Lane Departure Warning: enables the device to alert you when it detects you may be crossing a lane boundary 

unintentionally.

Proximity alerts settings
NOTE: you must have custom points of interest (POIs) loaded for proximity points alerts to display.
NOTE: this feature is not available in all areas.
Select  > Driver Assistance > Proximity Alerts.
Audio: sets the style of alert that plays when you approach proximity points.
Alerts: sets the type of proximity points for which alerts are played.

Settings 57



Dash Cam Settings
Select  > Dash Cam.
Camera placement: allows you to set the vehicle height and camera position, and align the dash cam.
Record on Startup: enables the dash camera to start recording video automatically when you turn on the device.
Video Resolution: sets the resolution and quality for dash cam recordings.
Incident Detection: sets the sensitivity for incident detection features. The device saves video automatically 

when it detects a possible driving incident.
Record Audio: enables or disables audio recording while you are recording with the dash cam.
Data Overlay: includes date, time, location and speed information in the recorded video.
Unsaved Videos: determines when the device deletes unsaved video footage. When the Delete When Full option 

is selected, the device deletes the oldest unsaved video when the memory card storage is full. When the 
Promptly Delete option is selected, the device continually deletes unsaved video more than three minutes old 
and deletes all unsaved video each time it is powered off. This is useful to help protect data privacy. While 
the Promptly Delete option is selected, you cannot view unsaved video in the gallery.

Backup camera settings
The backup camera settings allow you to manage paired Garmin backup cameras and camera settings. This 
menu appears on your navigation device only when the device is connected to a wireless camera receiver cable. 
See the owner's manual for your backup camera for detailed information about pairing cameras and camera 
settings. Go to garmin.com/backupcamera to purchase a Garmin backup camera.
Select  > Wireless Camera, and select a paired camera.
Unpair: removes the paired camera. You must pair the camera again before you can view it using this device 

and cable.
Rename: allows you to rename the paired camera.
Guidance Lines: shows or hides guidance lines and allows you to adjust the position of the guidance lines.

Display settings
Select  > Display.
Colour Mode: allows you to select day or night colour mode. If you select the Auto option, the device 

automatically switches to day or night colours based on the time of day.
Brightness: allows you to adjust the display brightness.
Display Timeout: allows you to set the amount of idle time before your device enters sleep mode while using 

battery power.
Screenshot: allows you to take a picture of the device screen. Screenshots are saved in the Screenshot folder of 

the device storage.

Traffic Settings
From the main menu, select  > Traffic.
Traffic: enables the traffic feature.

Units and time settings
To open the Units and Time settings page, from the main menu, select  > Units & Time.
Current Time: sets the device time.
Time Format: allows you to select a 12-hour, 24-hour or UTC display time.
Units: sets the unit of measure used for distances.
Position Format: sets the co-ordinate format and datum used for geographical co-ordinates.
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Setting the Time
1 From the main menu, select the time.
2 Select an option:

• To set the time automatically using GPS information, select Automatic.
• To set the time manually, drag the numbers up or down.

Language and Keyboard Settings
To open the Language and Keyboard settings, from the main menu, select  > Language & Keyboard.
Voice Language: sets the language for voice prompts.
text language: sets all on-screen text to the selected language.

NOTE: changing the text language does not change the language of user-entered data or map data, such as 
street names.

Keyboard language: enables keyboard languages.

Device and privacy settings
Select  > Device.
About: displays the software version number, the unit ID number and information on several other software 

features.
Regulatory: displays regulatory markings and information.
EULAs: displays the end-user licence agreements.

NOTE: you need this information when you update the system software or purchase additional map data.
Software Licences: displays software licensing information.
Device Data Reporting: shares anonymous data to improve the device.
Travel History: allows the device to store a record of the places you go. This allows you to view the trip log, use 

the Trip History feature and use myTrends suggested routes.
Reset: allows you to clear your travel history, reset settings or delete all user data.

Resetting Data and Settings
The device offers several options for deleting your user data and resetting all settings to the factory default 
values.
1 Select  > Device > Reset.
2 Select an option:

• To clear your travel history, select Clear Travel History.
This option deletes all records of the places you have travelled. It does not delete saved locations or 
installed maps.

• To reset all settings to the factory default values, select Reset Default Settings.
This option does not delete any user data.

• To delete all user data and reset all settings to the factory default values, select Delete Data and Reset 
Settings.
This option deletes all user data, including your saved locations, recently found locations and travel 
history. Installed maps are not deleted.

Device information
Viewing E-label Regulatory and Compliance Information
1 From the settings menu, swipe to the bottom of the menu.
2 Select Device > Regulatory.
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Specifications
Operating temperature range From -20° to 55°C (from -4° to 131°F)

Charging temperature range From 0° to 45°C (from 32° to 113°F)

Power input Vehicle power using the included vehicle power cable. AC power using an 
optional accessory (for home and office use only).

Battery type Rechargeable lithium-ion

Charging the Device
NOTE: this Class III product shall be powered by an LPS power supply.
You can charge the battery in the device using any of these methods.
• Connect the device to vehicle power.
• Connect the device to an optional power adapter accessory, such as a wall power adapter.

You can purchase an approved Garmin AC-DC adapter suitable for home or office use from a Garmin dealer 
or www.garmin.com. The device may charge slowly when connected to a third-party adapter.

Device maintenance
Garmin Support Centre
Go to support.garmin.com for help and information, such as product manuals, frequently asked questions, 
videos and customer support.

Map and Software Updates
For the best navigation experience, you should keep the maps and software on your device up to date.
Map updates provide the newest available changes to roads and locations in the maps used by your device. 
Keeping maps up to date helps your device find recently added locations and calculate more accurate routes. 
Map updates are large and may take several hours to complete.
Software updates provide changes and improvements to the device features and operation. Software updates 
are small and take a few minutes to complete.
You can update your device using two methods.
• You can connect the device to a Wi‑Fi network to update directly on the device (recommended). This option 

allows you to update your device conveniently without connecting it to a computer.
• You can connect the device to a computer and update it using the Garmin Express application (garmin.com

/express).

Connecting to a Wi‑Fi Network
The first time you turn on the device, it prompts you to connect to a Wi‑Fi network and register your device. You 
can also connect to a Wi‑Fi network using the settings menu.
1 Select  > Wireless Networks.
2 If necessary, select Wi-Fi to enable Wi‑Fi technology.
3 Select Search for Networks.

The device displays a list of nearby Wi‑Fi networks.
4 Select a network.
5 If necessary, enter the password for the network, and select Done.
The device connects to the network, and the network is added to the list of saved networks. The device 
reconnects to this network automatically when it is within range.
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Updating Maps and Software Using a Wi‑Fi Network
NOTICE

Map and software updates may require the device to download large files. Regular data limits or charges from 
your internet service provider apply. Contact your internet service provider for more information about data 
limits or charges.

You can update the maps and software by connecting your device to a Wi‑Fi network that provides access to the 
internet. This allows you to keep your device up to date without connecting it to a computer.
1 Connect the device to a Wi‑Fi network (Connecting to a Wi‑Fi Network, page 60).

While connected to a Wi‑Fi network, the device checks for available updates. When an update is available, 
appears on the  icon in the main menu.

2 Select  > Updates.
The device checks for available updates. When an update is available, Update Available appears below Map 
or Software.

3 Select an option:
• To install all available updates, select Install All.
• To install only map updates, select Map > Install All.
• To install only software updates, select Software > Install All.

4 Read the licence agreements, and select Accept All to accept the agreements.
NOTE: if you do not agree with the licence terms, you can select Reject. This stops the update process. You 
cannot install updates until you accept the licence agreements.

5 Using the included USB cable, connect the device to external power, and select Continue (Charging the 
Device, page 60).
For the best results, a USB wall charger that provides at least 2 A power output is recommended. Many 
USB power adapters for smartphones, tablets or portable media devices may be compatible.

6 Keep the device connected to external power and within range of the Wi‑Fi network until the update process 
is complete.

TIP: if a map update is interrupted or cancelled before it completes, your device may be missing map data. To 
repair missing map data, you must update the maps again using either Wi‑Fi or Garmin Express.

Device maintenance 61



Updating Maps and Software with Garmin Express
You can use the Garmin Express application to download and install the latest map and software updates for 
your device.
1 If you do not have the Garmin Express application installed on your computer, go to garmin.com/express and 

follow the on-screen instructions to install it (Installing Garmin Express, page 63).
2 Open the  Garmin Express application.
3 Connect your device to your computer using a USB cable.

The small end of the cable connects to the USB port  on your dēzlCam device, and the large end connects 
to an available USB port on your computer.

4 From your dēzlCam device, select Tap to Connect to Computer.
5 When your dēzlCam device prompts you to enter file transfer mode, select Continue.
6 In the Garmin Express application, click Add a Device.

The Garmin Express application searches for your device and displays the device name and serial number.
7 Click Add Device and follow the on-screen instructions to add your device to the Garmin Express application.

When setup is complete, the Garmin Express application displays the updates available for your device.
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8 Select an option:
• To install all available updates, click Install All.
• To install a specific update, click View Details and click Install next to the update you want.
The Garmin Express application downloads and installs the updates onto your device. Map updates are very 
large and this process may take a long time on slower internet connections.
NOTE: if a map update is too large for the internal storage of the device, the software may prompt you to 
install a microSD card in your device to add storage space (Installing a memory card for maps and data, 
page 67).

9 Follow the on-screen instructions during the update process to finish installing updates.
For example, during the update process, the Garmin Express application may instruct you to disconnect and 
reconnect your device.

Installing Garmin Express
The Garmin Express application is available for Windows® and Mac® computers.
1 On your computer, go to garmin.com/express.
2 Select an option:

• To view the system requirements and verify the Garmin Express application is compatible with your 
computer, select System Requirements.

• To install on a Windows computer, select Download for Windows.
• To install on a Mac computer, select Download for Mac.

3 Open the downloaded file, and follow the on-screen instructions to complete the installation.

Device Care
NOTICE

Avoid dropping your device.
Do not store the device where prolonged exposure to extreme temperatures can occur, as it can cause 
permanent damage.
Never use a hard or sharp object to operate the touchscreen as this may result in damage.
Do not expose the device to water.

Cleaning the outer casing
NOTICE

Avoid chemical cleaners and solvents that can damage plastic components.

1 Clean the outer casing of the device (not the touchscreen) using a cloth dampened with a mild detergent 
solution.

2 Wipe the device dry.

Cleaning the Touchscreen
1 Use a soft, clean, lint-free cloth.
2 If necessary, lightly dampen the cloth with water.
3 If using a dampened cloth, turn off the device and disconnect the device from the power.
4 Gently wipe the screen with the cloth.
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Cleaning the camera lens
NOTICE

Avoid chemical cleaners and solvents that can damage plastic components.

You should clean the camera lens regularly to improve the quality of recorded video.
1 Wipe the lens with a non-scratch lens cloth, optionally dampened with isopropyl alcohol.
2 Allow the lens to air dry.

Avoiding theft
• Remove the device and mount from sight when not in use.
• Remove the residue left on the windscreen by the suction cup.
• Do not keep your unit in the glove compartment.
• Register your device using the Garmin Express software (garmin.com/express).

Restarting the Device
You can restart your device if it stops functioning.

Hold the power key for 12 seconds.

Removing the Device, Mount and Suction Cup

Removing the Device from the Mount
1 Press the release tab or button on the mount.
2 Tilt the top of the device downwards and lift the device from the mount.

Removing the Mount from the Suction Cup
1 Turn the device mount to the right or left.
2 Apply pressure until the socket on the mount releases the ball on the suction cup.

Removing the Suction Cup from the Windscreen
1 Flip the lever on the suction cup towards you.
2 Pull the tab on the suction cup towards you.

Data management
The device has a memory card slot for additional data storage.
NOTE: the device is compatible with Windows 7 and newer, and Mac OS 10.7 and newer.

About memory cards
You can purchase memory cards from an electronics supplier, or purchase pre-loaded Garmin mapping 
software (www.garmin.com). Memory cards can be used to store files such as maps and custom POIs.

Formatting the Dash Cam Memory Card
The dash cam requires a memory card formatted using the FAT32 file system. You can use the device to format 
your card using this file system.
You should format your memory card at least once every 6 months to help extend the useful life of the memory 
card. You must also format a brand new memory card if it is not formatted using the FAT32 file system.
NOTE: formatting the memory card deletes all data on the card.
1 Select  > Gallery.
2 Select  > Format Memory Card.
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Connecting the Device to Your Computer
You can connect the device to your computer using a USB cable.
1 Plug the small end of the USB cable into the port on the device.
2 Plug the larger end of the USB cable into a port on your computer.
3 From your dēzlCam device, select Tap to Connect to Computer.
4 When your dēzlCam device prompts you to enter file transfer mode, select Continue.
A picture of your device connected to a computer appears on the device screen.
Depending on your computer operating system, the device appears as either a portable device, a removable 
drive, or a removable volume.

Transferring data from your computer
1 Connect the device to your computer (Connecting the Device to Your Computer, page 65).

Depending on your computer operating system, the device appears as either a portable device, a removable 
drive, or a removable volume.

2 On your computer, open the file browser.
3 Select a file.
4 Select Edit > Copy.
5 Browse to a folder on the device.

NOTE: for a removable drive or volume, you should not place files in the Garmin folder.
6 Select Edit > Paste.

Disconnecting the USB cable
If your device is connected to your computer as a removable drive or volume, you must safely disconnect your 
device from your computer to avoid data loss. If your device is connected to your Windows computer as a 
portable device, it is not necessary to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove Hardware icon in the system tray and select your 
device.

• For Apple® computers, select the device, and select File > Eject.
2 Disconnect the cable from your computer.

Troubleshooting
My video recordings are blurry
• Clean the camera lens (Cleaning the camera lens, page 64).
• Clean the windscreen in front of the camera.
• Verify the area of the windscreen in front of the camera is cleared by the windscreen wipers, and move the 

device, if necessary.
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My memory card has degraded and needs to be replaced
All microSD memory cards wear out after they are overwritten a large number of times. Periodically formatting 
the card can extend the useful life and improve performance. Because the dash camera records continuously, 
you may need to replace the memory card periodically. Your device detects memory card errors automatically 
and alerts you when it is time to format or replace your memory card.
You can take these actions to help extend the useful life of the memory card.
• Format the memory card at least one time every six months.
• If the device displays a memory card error alert, first try formatting the memory card and then, if necessary, 

replace the memory card.
• Turn off the device when your vehicle is not in use.

If your device is not connected to an ignition-switched vehicle power outlet, you should turn off the device 
when your vehicle is not in use to prevent the dash camera from recording unneeded footage.

• Use a memory card with a higher storage capacity.
Because higher-capacity memory cards are overwritten less frequently, they usually last longer.

• Use a high-quality memory card with a speed rating of class 10 or higher.
• Purchase your replacement memory card from a high-quality manufacturer and a reputable vendor.

My video recordings are choppy or incomplete
• For the best camera and video results, use a high-quality memory card with a speed rating of class 10 or 

higher.
A slower memory card may not record video quickly enough.

• If you are viewing videos on your smartphone using a wireless connection to the camera, try viewing them in 
another location with less wireless interference, or try transferring videos to the smartphone.

• Transfer important recordings to a computer or smartphone, and format the memory card.
• If the device displays a memory card error alert, first try formatting the memory card and then, if necessary, 

replace the memory card.
• Update your device to the latest software (Map and Software Updates, page 60).

The suction cup will not stay on my windscreen
1 Clean the suction cup and windscreen with surgical spirit.
2 Dry with a clean, dry cloth.
3 Mount the suction cup (Mounting Considerations, page 2).

My device is not acquiring satellite signals
• Verify the GPS simulator is turned off (Navigation settings, page 56).
• Take your device out of car parks and away from tall buildings and trees.
• Remain stationary for several minutes.

The device does not charge in my vehicle
• Verify that the vehicle is turned on and is supplying power to the power outlet.
• Verify that the interior temperature of the vehicle is within the charging temperature range indicated in the 

specifications.
• In the vehicle fuse box, verify that the fuse for the vehicle power outlet is not broken.
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My battery does not stay charged for very long
• Decrease the screen brightness (Display settings, page 58).
• Shorten the display timeout (Display settings, page 58).
• Decrease the volume (Adjusting the volume, page 6).
• Turn off the Wi-Fi radio when it is not in use (Wireless network settings, page 57).
• Put the device in power saving mode when not in use.
• Keep your device away from extreme temperatures.
• Do not leave your device in direct sunlight.

My device does not connect to my phone
• Select  > Wireless Networks > Bluetooth.

The Bluetooth option must be enabled.
• Enable Bluetooth wireless technology on your phone and bring your phone within 10 m (33 ft.) of the device.
• Verify your phone is compatible.

Go to www.garmin.com/bluetooth for more information.
• Complete the pairing process again.

To repeat the pairing process, you must unpair your phone and device (Deleting a paired phone, page 39), and 
complete the pairing process (Live services, traffic and smartphone features, page 34).

Appendix
Installing a memory card for maps and data
You can install a memory card to increase the storage space for maps and other data on your device. You can 
purchase memory cards from an electronics supplier. The device supports microSD memory cards from 4 to 
256 GB. Memory cards must use the FAT32 file system format. Memory cards greater than 32 GB must be 
formatted using the device.
1 Locate the map and data memory card slot on your device (dēzlCam Device Overview, page 1).
2 Insert a memory card into the slot.
3 Press it in until it clicks.

Viewing GPS signal status
Hold  for three seconds.

Purchasing additional maps
1 Go to your device product page at garmin.com.
2 Click on the Map tab.
3 Follow the on-screen instructions.

Purchasing accessories
• Optional accessories are available at garmin.com or from your Garmin dealer.

European Emission Standards
The European Emission Standards are standards for exhaust emissions that limit the amount of air pollutants 
that are released from new vehicles sold in Europe.
You can find your vehicle's emission standards in your vehicle's owner's manual, your vehicle registration 
documents, or printed on your vehicle's door frame. If you are unable to locate the emission standard for your 
vehicle, you can contact your vehicle dealer or manufacturer for more information.
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Garmin PowerSwitch
 WARNING

Garmin strongly recommends having an experienced installer with the proper knowledge of electrical systems 
install the device. Incorrectly wiring the power cable can result in damage to the vehicle or the battery and can 
cause bodily injury.

You can use a connected Garmin PowerSwitch device to control lights, fans and more from your dēzlCam 
device.

Mounting Considerations
• The device must be mounted close to the battery and within the range of the supplied power cable.
• The mounting surface must be strong enough to support the weight of the device.
• The location must allow room for the routing and connection of all cables.

Mounting the Device
Before you can mount the device, you must select a mounting location and purchase the appropriate hardware 
for your mounting surface.

NOTICE
Avoid wires, gauges, air bags, air bag covers, heating, ventilation, and air conditioning and other items when 
drilling pilot holes and attaching the mount to the vehicle. Garmin is not responsible for any damages or 
consequences arising from the installation.

1 Place the mount on the selected location.

2 Using the mount as a template, mark the two screw locations .
3 Drill pilot holes (optional).

For some types of mounting material, drilling pilot holes is necessary. Do not drill through the mount.
4 Securely fasten the mount to the surface using the appropriate hardware for your mounting surface.
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Opening the Front Cover
You must open the front cover to make electrical connections.
1 Lift the front cover latch  and rotate it anticlockwise.

2 Pull the front cover off of the device.
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Connecting Accessories
NOTICE

Do not use the device to control or power a winch. Failure to follow this notice could cause damage to your 
vehicle or your device.
Do not connect a power source to an accessory output terminal. Failure to follow this notice could cause 
damage to your vehicle or your device.

Accessory requirements:
• Verify the amperage rating of each accessory before wiring it to the Garmin PowerSwitch device. The device 

supports accessories up to 30 A for each channel and a maximum of 100 A for the entire system.
• Use 10 AWG (6 mm2) wires for accessories that use 20 to 30 A.
• Use 12 AWG (4 mm2) wires for accessories that use 10 to 20 A.
• Use 14 AWG (2.5 mm2) wires for accessories that use less than 10 A.
• Use the appropriate size terminals for all accessory connections.
• Crimp all terminal connectors securely.
1 Connect the positive wire from the accessory  to one of the accessory terminals  on the Garmin 

PowerSwitch device.

2 Connect the negative or ground wire  to an unpainted ground stud  on the vehicle frame, to a ground 
distribution block or directly to the negative terminal on the battery.

 CAUTION
Do not connect the accessory ground wires to the ground terminal (GND) on the Garmin PowerSwitch device, as 
doing so could result in personal injury or property damage, or could negatively impact device functionality.
3 Verify that all electrical connections are tight and will not come loose during use.

Connecting a Control Input
You can connect to the control terminals to enable the Garmin PowerSwitch device to turn on customisable 
outputs. For example, you can connect your vehicle ignition switch to a control input terminal to turn on 
accessories automatically each time you start your vehicle. The control terminals detect a signal from 3.3 V to 
18 V. You can configure output functions with the Garmin PowerSwitch app.

Connect the control wire from the control source in your vehicle to one of the two control terminals on the 
Garmin PowerSwitch device.
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Connecting the Device to Vehicle Power
Before you can connect the device to vehicle power, you must remove the warning tag from the +12V terminal 
on the device.
You should always confirm all electrical connections are secure and will not come loose while operating the 
device.
1 Connect the large ring end of the included ground wire  to the negative terminal on the vehicle battery.

2 Connect the small ring end of the ground wire to the GND terminal  on the device.
3 Connect the small ring end of the included 12-V cable to the +12V terminal  on the device.
4 Tighten the 3/8 in. nut on the +12V terminal to a maximum torque specification of 4.52 N-m (40 lbf-in.).

You should confirm the nut cannot be loosened by hand.

NOTICE
Do not overtighten the +12V terminal to prevent damage to the terminal.
5 Connect the large ring end of the 12-V cable  to the positive terminal on the vehicle battery.

Pairing with a Garmin Navigation Device
You can pair your Garmin PowerSwitch device with a compatible Garmin navigation device.
1 Turn on power to your Garmin PowerSwitch device and place your compatible Garmin navigation device 

within 1 m (3.3 ft.) of it.
2 On your compatible navigation device, open the Garmin PowerSwitch app.
3 Follow the on-screen instructions to complete the pairing and setup process.
The main app dashboard appears. After the devices are paired, they connect automatically when they are turned 
on and within range.

Appendix 71



Garmin PowerSwitch Specifications
Dimensions (D x W x H) 75 x 125 x 32 mm (2.95 x 4.92 x 1.26 in.)

Operating temperature range From -25° to 85°C (from -13° to 185°F)

Wireless frequency 2.4 GHz @ 13 dBm

Power input From 12 to 16 V using the included vehicle power cable.

Maximum accessory output 30 A

Maximum system output 100 A

Current draw with all outputs off 3 mA

Water rating IEC 60529 IPX71

Troubleshooting
My Garmin PowerSwitch will not stay connected
• Verify the Garmin PowerSwitch device is receiving power.
• Verify that Bluetooth technology is enabled on your paired navigation device or smartphone.
• Move the navigation device or smartphone closer to your Garmin PowerSwitch device.
• Verify that your vehicle's battery is supplying at least 12 V of power.

The Garmin PowerSwitch device turns off all outputs automatically to preserve your vehicle's battery if it is 
receiving less than 11 V of power (My accessories are not receiving power, page 72).

My accessories are not receiving power
• Verify that the Garmin PowerSwitch device is receiving power from the vehicle battery.
• Verify that your vehicle's battery is supplying at least 12 V of power.

The Garmin PowerSwitch device turns off all outputs automatically to preserve your vehicle's battery if it is 
receiving less than 11 V of power. Outputs turn back on when the device detects more than 12 V of power.

• Verify that all electrical connections are secure and will not come loose while operating the vehicle.
• Verify that each connected accessory draws less than 30 A.

If an accessory draws more than 30 A, the device turns off that output automatically.
• Verify that the total system load is less than 100 A.

If the device detects a system load of more than 100 A, it turns off all outputs automatically.
• Inspect all electrical connections for an electrical short circuit.

1 The device withstands incidental exposure to water of up to 1 m for up to 30 min. For more information, go to www.garmin.com/waterrating.
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